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Introduction to 
DaVinci Resolve 20
DaVinci Resolve 20 includes more than 100 new features including an incredible collection of 
new-before-seen AI tools designed to speed up every stage of your post production workflow so 
you can focus more on the creative aspects of filmmaking.

This new features guide provides a quick overview of the new features.
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General Improvements
Among many new general improvements, DaVinci Resolve 20 has a new AI Voice Convert 
tool and several quality of life improvements.

AI Voice Convert
DaVinci Resolve 20 adds an incredibly sophisticated AI-driven voice conversion tool that 
allows you to essentially swap one speaking voice for another. The use cases for this tool are 
wide reaching and even somewhat controversial, however this Voice Convert toolset can be 
an invaluable resource in a post production. It allows you to take a generated voice model 
that has been captured by DaVinci Resolve and “drive” that voice model using another voice 
recording as its foundation.

In simple cases, you can replace your own voiceover tracks with a voice that has more depth 
and gravitas to it, or even switch the gender of your own voice if you feel it’s more appropriate 
for the subject matter. Perhaps you recorded audio in a noisy environment and wanted to make a 
pristine version instead by using your own voice as a model, to replace your original noisy tracks. 
In more complicated scenarios, you can train your own voice convert model on your actor’s voice 
patterns and use that to change and replace their previous voiceover, without having to get 
them back into the recording booth. Finally, it is even possible to change the voice of an actor 
completely to another voice all while staying perfectly in sync with the picture. The inflection, 
pitch variations, and emotion of the original all remain; it just sounds like someone else.

Needless to say, using this powerful tool requires a certain level of responsibility on the 
part of the user. Privacy, copyright, and union laws and rules are all in flux at the moment 
around AI-generated content, and it’s necessary to carefully navigate the ethics involved in 
its professional use. 

The Voice Convert tool
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Using Voice Convert
Like most of DaVinci Resolve’s AI tools, using Voice Convert is very simple, with all of the 
complex processing involved handled by the voice model.

Voice Convert analyzing a clip

To use Voice Convert to change one voice to another:
1	 Place the clip or clips you want to change the voice of in the timeline, and select them.

2	 Right-click on the clip and select Voice Convert from the context menu, or select 
Clip > AI Tools > Voice Convert in the main menu.

3	 Select the track that you want the new audio to appear in (including overwriting the original).

4	 Select the file name you want the new audio to be named.

5	 Select the Voice Model you want to use for the new audio (you can make your own custom 
voice models as explained below) and its parameters.

6	 Click Render to start the Voice Convert process.

At this point the Voice Convert dialog will appear showing you the progress of the 
conversion. Depending on the length and number of clips selected, this can take some 
time. When the process is done, the new audio will appear in the timeline in the exact 
same place as the original audio (or on the same place in another track if that option was 
selected). The new audio clips will also appear in the Media Pool. 

Simply play back the timeline to audition the new voice. You can change the audio back 
to the original by right-clicking on a clip and selecting Revert to Original Voice from the 
context menu.

TIP: While you can drive voices with different accents, Voice Convert generally can’t 
recreate another accent. For example, if you have a voice model that is a speaker 
with a British accent and drive that voice with an American accent, you get more of an 
American version of the British-accented speaker. But if you speak with a British accent 
when driving the British voice model, it will work well.
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Voice Convert Settings
Each voice conversion requires selecting set up parameters to drive the model.

Track: Select which track you want the new audio to be placed on. The default is Render in 
Place, which will overwrite the original audio.

File Name: Set the file name for the new audio clip. You can enter a specific name or 
use the metadata variables to create a template for file naming. By default the name is 
ClipName-(Voice Model Name).

Voice Model: Select which voice model you wish to use for the new audio. There are some 
built-in options that come with DaVinci Resolve, and any custom options you create will also 
be available here.

Tight Matching to Source: Check this box to tightly follow the pitch, intonation, and volume 
variance of the source voice. Uncheck this box to have a looser interpretation using the 
Pitch Variance tool.

Pitch Variance: When the Tight Matching to Source box is unchecked, this tool becomes 
active. Lower values create a more monotone interpretation, while higher values have more 
variance in pitch.

Pitch Change: Use this slider to create a deeper (negative values), or higher (positive 
values) voice based on the model. The values are in semitones and can be adjusted in 100 
cents (.1 semitone) increments.

Creating Your Own Voice Models
It is possible to create your own voice models for use with Voice Convert. These can be of your 
own voice or even someone else’s that you have the rights to. This section goes over some best 
practices to get a clean and usable voice model.

Preparing the Voice Model Assets
You will get the best results using ten minutes or so of clean, high quality recordings of the 
voice to be modeled. The audio should be free of excessive ambiance and noise, with little to 
no dynamics processing. You will want consistent material that sounds natural. It can be useful 
to have a variety of emotions expressed as well, if you want to hear those results for the driven 
voice. Treat it like a voice over audition; show your range.

These voice assets do not necessarily need to be in one long clip, however if there are a lot 
of separate files, it can be helpful to consolidate them all in a single bin for organization. The 
multiple clips should be of consistent quality, without audio variations in the recorded sources.
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Creating the Voice Model
To generate your own voice model, select one or more clips for analysis in the Media Pool, 
right-click and choose AI Tools> DaVinci AI Tools Voice Training from the context menu. If this 
is the first time you’ve run this tool, DaVinci Resolve will open up the Resolve Extras Download 
Manager to install the required support files.

Voice model generation

Initially a warning splash screen appears to ensure you assume full responsibility for how you will 
use this tool. Once you hit accept, The DaVinci AI Voice Training dialog appears, and there are 
two options to set. 

Voice Model Name: Enter a descriptive name for your new model. 

Quality: Choose Faster or Better mode for analysis. Better takes about 3x the time as Faster, 
and 10 minutes or so of material can take a few hours to complete, depending on your 
computer’s power.

Initially creating a voice model launches a foreground process. Then once the initial analysis is 
complete, it will switch to a background process, allowing you to continue to use DaVinci Resolve 
for other purposes or other apps while it finishes. 

 

Voice model progress

NOTE: Creating a voice model will use a lot of CPU and GPU power, so multi-tasking while 
it’s working may be challenging. You can also take the opportunity to test just how loud 
your computer fans are as they ramp up to cool your system from the massive AI work.
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You can see the progress of the model in the Voice Model Generation Progress indicator 
in the bottom right corner, or by selecting Workspace > Voice Model Progress. 

Voice Model Generation Progress indicator will 
slowly fill blue as the voice model finished. Hover over 
the top to get an ETA and progress finished tooltip. 

You can also alternatively choose to pause or discard the in-progress model 
instead. Quitting DaVinci Resolve will also pause the background process, and it will 
automatically start up again the next time DaVinci Resolve is launched.

Once the model is complete, the new voice preset will appear for use in the 
Voice Convert dialog.

User Definable Location for 
Media Created in DaVinci Resolve
In DaVinci Resolve 20, when creating a new project, you now have the opportunity to choose a 
specific folder on your system to hold all generated media created for that project. Generated 
media includes things like new audio files created from the Voiceover tool and Voice Convert—
essentially any type of new media created inside DaVinci Resolve. This allows you to make sure 
all the media for a project is in one common location, making it easier to hand off, move, or relink 
media, rather than have some media in DaVinci Resolve’s internal file structure and some on a 
media drive.

When creating a new project, you can set a folder for all generated 
media to be saved into using the Media Location field.

Proxy, Cache, and Gallery still retain their own separate media folders found in the 
Project Settings > Master Settings > Working Folders section, and you will now find this 
Project Media Location option there as well if you wish to change it. By default, the Media 
Location is still in the first media storage location set in Preferences > Media Storage, just 
as before.
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DaVinci Resolve will automatically 
create new subfolders at your 
chosen media location based on 
media type, which makes it easy 
to send some or all generated 
media to another location.

Inside the media location, 
DaVinci Resolve will 
create subfolders 
automatically to organize 
any media generated 
from within the program.

DaVinci Resolve Extras 
Download Manager
As DaVinci Resolve evolves to incorporate more AI-based models, there is a tradeoff in file size. 
These AI models tend to be large datasets that not all users will want or need to use. To help 
with this DaVinci Resolve 20 has introduced the Extras Download Manager, allowing you to pick 
and choose which optional functionality you want to add to DaVinci Resolve.

The Extras Download Manager can be found at DaVinci Resolve > 
Extras Download Manager.

The Extras Download Manager

To use the Extras Download Manager, simply view the packages available, and select 
download. You can remove a package in the same interface by clicking on the trashcan 
icon next to the package name. Downloads will happen in the background while you 
continue to work. From time to time these packages will be updated, and you will be 
notified here if your current package is out of date.

Currently the Download Manager contains packages for Extended AI Transcription 
Support Languages, as well as AI Voice Training.
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Remote Monitor Now Installs 
with DaVinci Resolve on macOS
The DaVinci Remote Monitor application, which allows users to see the output of a viewer 
streamed over the internet in DaVinci Resolve, is now automatically installed along with the main 
program in macOS.

User Preference for Automatic 
Cache Management
A new User Preference allows you to automatically delete your local cache after a certain 
number of days to keep your drive from filling up with older projects. Of course, you can always 
manage these files manually from the Playback > Manage Render Cache menu, but this new 
preference lets you set and forget a cleanup operation.

DaVinci Resolve > Preferences > User > Cache Management> Delete cache older 
than xx days.

Check the box to automatically delete any cache files older than the number of days set 
in the field.

Enable Dual Screen Windows 
in Ultrawide Displays
If you have an ultrawide monitor with an extremely horizontal aspect ratio, you can now enable 
DaVinci Resolve’s dual-screen setup to take advantage of all your screen real estate, even 
though technically it’s one monitor.

Preference to Import All Clips with 
Multi Mono Audio Configuration
There is now a preference that allows you to import any multichannel audio in a multiple mono 
configuration. This lets you take any Stereo, 5.1, or other multitrack sources, and automatically 
convert them to multiple mono files with the same number of tracks when you add them to the 
Media Pool. 

You can find this option at DaVinci Resolve > Preferences > User > Editing > General 
Settings > Configure clips as multi-mono on import.
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Popup Dialog to Show 
Connected Control Panels
In the lower-right corner of the DaVinci Resolve 20 interface, you will find a control panels 
popup box. Clicking on this icon shows you all currently connected control panels, how they are 
connected, and their battery status.

The Control Panels pop up icon

Ability to Filter Which Fonts 
are Visible in Text+
You can now explicitly limit the font options shown for your text elements. This lets you set a 
white list of fonts that you are cleared to use and hide all other fonts.

To setup an allowed fonts list: 

1	 Check the box in Preferences > User > Editing > Text > Display Only Specific Fonts.

2	 Select a font filter file. 

A font filter file is any UTF-8 text file with a combination of explicit font names or text with 
asterisk wildcards to match multiple fonts, listed one entry per line.

*Gothic* (any font name with Gothic in it)

Arial

Helvetica* (any font name beginning with Helvetica)

Open Sans
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Data burn Option and Tag 
for Synced Audio Properties
From the Data Burn-in dialog, you can now enable on-screen synced audio timecode and synced 
audio file name displays to show a clip‘s synced audio properties instead of its source properties. 
Choose either the checkboxes for the synced audio timecode or name, or choose Custom Text, 
and type “%synced” to select the appropriate property.	

Audio Timecode and File name burn-ins

Support for NVIDIA Blackwell 
GPUs with CUDA 12.8
DaVinci Resolve 20 provides full support for NVIDIA’s new Blackwell series of GPUs and 
CUDA 12.8 features.
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Cut and Edit
DaVinci Resolve 20 has major new improvements to its editing capabilities across both the Cut 
and Edit pages. A newly upgraded Keyframe and Curve Editor, as well as several new AI tools for 
audio work highlight the release.

Upgraded Keyframe and Curve Editor
The Keyframe and Curve Editors in DaVinci Resolve 20 have been upgraded with a new 
interface. Creating an entirely new panel for these operations, rather than confining them to the 
timeline, gives you a more efficient layout that makes precise keyframing adjustments easier. 
This new Keyframe and Curve Editor has fully replaced the older version.

The new Keyframe and Curve Editor is accessible from both the Cut and Edit pages as its own 
panel. Simply click on the Keyframes tab in the upper left to open it. By default, the Keyframe 
Editor is displayed, showing you all of the keyframable parameters in the Video Inspector and 
any existing keyframes that may have been added there. Clicking on the Curve icon in the upper 
left will take you to the Curve Editor

The Keyframe Editor
The Keyframe Editor in the Timeline is the most powerful way of exposing all of a clip’s keyframes 
and adjusting their timing and interpolation.

The Keyframe Editor showing all the video attributes found in the Inspector

The Keyframe Editor exposes one keyframe track for each parameter that’s possible to be 
keyframed on the selected clip. Initially this looks like a big list of complicated items to keep track 
of (no pun intended), but it does provide a good overview of everything that’s animatable for your 
clip. However, the Keyframe Editor has several tools to help remove unnecessary clutter and only 
focus on the exact parameters you’re interested in animating. These keyframe tracks let you edit 
keyframes in context of the actual clip durations in the Timeline.
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Keyframe tracks: Transform is the track group (shown by the 
disclosure triangle), Zoom and Position XY are tracks within that 
group. Selected keyframes are shown white with an outline.

The tracks are also grouped by parameter category. For example, all the Transform, 
Cropping, and Speed parameters are all encapsulated by group tracks. If you’d added 
keyframes to the Zoom and Position parameters, these keyframes also appear within 
a single keyframe track labeled Transform, while Crop Left and Crop Right adjustments 
appear on another group keyframe track labeled Cropping. Moving a keyframe on 
a group track will adjust the keyframes at the same position for all of its enclosed 
parameters at the same time.

Each group keyframe track has a disclosure arrow that lets you show or hide each 
individual parameter within that group. For example, clicking the Transform keyframe 
track’s disclosure arrow shows the Zoom and Position tracks, so you can adjust those 
individual keyframes.

Organizing the Keyframe Editor
While keyframing itself is a fairly simple process, the sheer number of keyframable attributes can 
be overwhelming, so unless you’re planning on animating something incredibly complicated, it’s 
probably a better idea to focus the Keyframe Editor’s interface on just what you need.

To show or hide tracks by parameter group
	� Click on the small disclosure triangle next to the group track’s name. For example, if you 

were only intending to keyframe parameters in the Transform group (Zoom, Position, etc.), 
you could close the disclosure triangles in the Cropping and Speed groups to hide the 
excess tracks.

	� Click on the 3-dot option menu in the right of the Parameters column, and choose 
Expand All Parameters to open every group track to see their enclosing parameters.

	� Click on the 3-dot option menu in the right of the Parameters column, and choose 
Collapse All Parameters to close every group track to hide their enclosing parameters. 

To show only tracks that already have keyframes
	� Click on the 3-dot option menu in the right of the Parameters column, and choose 

Display Parameters with Keyframes. This will show only tracks that have already at least one 
keyframe assigned to them, and their enclosing group tracks.

To show only Video related tracks
	� Click on the 3-dot option menu in the right of the Parameters column, and choose Display All 

Video Parameters. This will hide any keyframe tracks that control audio related functions 
from the Audio Inspector.
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To show only specific tracks only
	� Click on the 3-dot option menu in the right of the parameters column, and choose 

Display Selected Parameters. You can then choose checkboxes for Video and Audio. 
Clicking on these will open up another set of checkboxes that allow you to specify exactly 
which tracks you want to show.

To undock and resize the Keyframe Editor
	� Click on the undock icon in the Keyframe Editor to open it as an independent window. 

You can then resize the window to expand the Keyframe Editor to any size that you need.

Using the Keyframe Editor
Once the Keyframe Editor is open and the parameters you wish to animate are exposed, 
you have many ways to add, delete, and manipulate keyframes along these tracks.

The Keyframe Track controls (L-R): Toggle Curve Visibility, Toggle Keyframe Lock, 
Track Color, Track Name, Keyframe, Reset Keyframes, Keyframe Position

Keyframe Track Controls:

Toggle Curve Visibility: Click on this icon to turn this track’s curve 
visibility on or off in the Curve Editor.

Toggle Keyframe Lock: Click on this icon to turn the keyframe lock 
on or off to prevent accidental changes.

Track Color: A small colored dot shows the color of the track’s 
curve in the Curve Editor.

Track Name: The name of the track parameter.

Keyframe: Clicking the diamond will add a new keyframe at the current 
position. If there is an active keyframe at the position, this diamond will be 
orange, otherwise white. The left and right arrows will skip to the previous 
and next keyframes respectively. 

Reset Keyframes: Removes all keyframes in the track.

Keyframe Position: Shows all set keyframes for the track and 
their position in the clip.
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Methods of adding and selecting keyframes in the Keyframe Editor:
	� To add new keyframes to the Keyframe Editor: Adjust the playhead to where you want 

the keyframe, then click on the gray diamond next to the parameter’s name. The diamond 
will turn orange to let you know a keyframe has been added, and it will also appear on the 
parameter track at the playhead position. Subsequent keyframes can be added on this 
track by pressing Command [ to add another keyframe.

	� To select a single keyframe: Click a single keyframe to select it.
	� To select multiple discontiguous keyframes: Command-click all keyframes you want to 

select, whether they’re next to one another or not.
	� To select multiple contiguous keyframes: Drag a bounding box within the keyframe track 

around multiple keyframes to select them all at once.
	� To move one or more keyframes: Select one or more keyframes and drag left or right.

Methods of Cutting, Copying, Pasting, and Deleting Keyframes:
	� To cut or copy, and paste one or more keyframes: Make a selection of keyframes, and 

use the Cut (Command-X) or Copy (Command-C) key shortcuts. Then, move the playhead to 
where you want the first of the copied keyframes to start, and press Paste (Command-V).

	� To delete one or more keyframes: Select the keyframe(s) you want to delete and 
press Delete.

IMPORTANT: Keyframes on the Timeline can exist past a clip’s current extents. 

For example, if you set several keyframes on a clip, then trim its duration on the Timeline 
past one of the keyframes, that keyframe is still there and fully functional, just not visible. 
You can still navigate to these invisible keyframes by using the Previous “[“ and Next “]” 
keyframe commands or using the keyframe controls in the Inspector.

Keyframe Editor Controls

The Keyframe Editor controls (L-R): Curve Editor, Keyframe Editor, Detail Zoom, 
Full Extend Zoom, Zoom Slider, Expand, Option Menu

Curve Editor: Click this icon to open the Curve Editor.

Keyframe Editor: Click this icon to open the Keyframe Editor.

Detail Zoom: Zooms the Keyframe Editor in around the playhead position.

Full Extend Zoom: Zooms the Keyframe Editor out to show the range of the 
whole clip.
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Zoom Slider: Lets you choose a custom zoom level for the Keyframe Editor.

Expand: Opens the Keyframe and Curve Editor in its own resizable window.

Option Menu:
Display Time Ruler in Seconds: Shows the Time Ruler in HH:MM:SS:FF 
timecode format based on the timeline.
Display Time Ruler in Frames: Shows the Time Ruler as number of frames 
since the timeline start.
Snap Keyframes to Grid: When enabled in the Curve Editor, this snaps 
keyframe control points to the grid markings on the graph.
Show Curve Tooltips: When enabled in the Curve Editor, placing the pointer 
over a curve will show its track name and value at the given point.

Parameters: Shows a list of keyframable parameters. 

Option Menu:
Display Parameters with Keyframes: Only shows tracks with existing 
keyframes and hides all others.
Display All Video Parameters: Shows all keyframable tracks found in the 
Video Inspector and hides all others.
Display Selected Parameters (Video & Audio): Opens a checkbox to turn on 
or off individual track visibility. In addition, if you’ve added a keyframable Open 
FX or Resolve FX to the clip, you can select those parameters here.
Expand All Parameters: Opens every group track to see their 
enclosing parameters.
Collapse All Parameters: Closes every group track to hide their 
enclosing parameters.

Opening the Keyframe Tray in the Timeline

In addition to the dedicated 
Keyframe Editor panel, you can 
also expose a keyframe tray on 
the timeline by selecting the 
Show Keyframe Tray icon on the 
main timeline toolbar in both the 
Cut and Edit pages. 

This keyframe tray shows all 
the keyframes of the currently 
selected clip on the timeline and 
operates in the same way as the 
Keyframe Editor.

You can open up the Keyframe Editor 
directly in the timeline by clicking on the 
Show Keyframe Tray icon (circled red).
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Opening the Keyframe and Curve Editor in Its Own Window
If you are doing extensive keyframing in the Edit page, you can open up the Keyframe and Curve 
Editor in its own resizable window to give you more space to work with. To do so, click on the 
Expand icon in the upper right of the Keyframe Editor.

The Keyframe and Curve Editor can be expanded to its own resizable window.

The Curve Editor
If you want to work with keyframes in even more detail, you can use the Curve Editor. When 
clicked, the the Curve Editor expands to accommodate a large graph in which you can freely 
adjust both the timing and value of selected keyframes, while also providing optional bezier 
spline controls used to create smooth curves with which to adjust the acceleration of animated 
changes from one value to another. 

To open the Curve Editor:

•	 Click on the Curve icon in the upper left of the Keyframe Editor.

When opened, any track that has keyframes will appear as a colored line on the graph, 
with control points along the line at the keyframe position. You can hover the pointer 
over a line to display its track name (and its current value) in a popup. The line color 
will also match the track color in the Keyframe Editor. You can open and close multiple 
parameters into the Curve Editor, using the Parameters menu that lets you choose which 
tracks are exposed via checkboxes. At the bottom of the Curve Editor is a keyframe track 
identical to the Keyframe Editor that displays the keyframes for the selected curve.
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While you can only work on one curve at a time, you can choose which is selected 
for editing by clicking any dimmed curve in the Curve Editor. Using the control points 
exposed by each curve, you can edit parameters, alter keyframe timing, and change 
each control point’s interpolation to create custom easing effects affecting the 
acceleration of change from one keyframe to the next.

The Curve Editor showing the timing and values of selected parameters

Methods of adding and selecting keyframes in the Curve Editor:

To change which curve you’re editing: Click the Parameters menu and choose which curves 
you want to expose to work on. If multiple curves are open in the Curve Editor, click any dimmed 
curve in the background to highlight it for editing.
To add new keyframes to a curve: Option-click anywhere on a curve to add a new control 
point. You can also select the Add Keyframes icon at the top of the toolbar, which will let you add 
multiple keyframes to a curve, just by clicking on it.
To duplicate one or more keyframes: Make a selection of keyframes, then press Command-C to 
copy, move the playhead to where you want to paste them, and press Command-V. This can be a 
good way to quickly loop a repetitive animated effect you’ve created.
To select a single keyframe: Click a single control point to select it. You can perform the same 
operation on the keyframe track at the very bottom of the Curve Editor.
To select multiple discontiguous keyframes: Command-click all control points you want to 
select, whether they’re next to one another or not. You can perform the same operation on the 
keyframe track at the very bottom of the Curve Editor.
To select multiple contiguous keyframes: Click the first keyframe you want to select, and then 
shift-click the last keyframe you want to select, and all keyframes between will also be selected, 
or drag a bounding box within the Curve Editor around multiple keyframes to select them all 
at once. You can perform the same operation on the keyframe track at the very bottom of the 
Curve Editor.
To select all keyframes: If the Keyframe Editor is open and it has focus (by clicking anywhere 
within it), then pressing Command-A will select all keyframes within that Keyframe Editor.
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Methods of adjusting keyframes in the Curve Editor:

To drag one or more keyframes freely on a curve: Select one or more control points and drag 
left or right to retime them, and up or down to change their value. A popup will display the track 
name and the updated value as you move it.
To drag one or more keyframes on a curve in only one direction: Select one or more control 
points, then hold the Shift key while dragging either vertically or horizontally to constrain 
keyframe adjustment within that single direction.

Methods of changing keyframe interpolation/easing/smoothing:

To change one or more Linear keyframe to Ease In or Ease Out: Eased keyframes create 
animated changes that begin slowly and accelerate to full speed, or slow down gradually to 
decelerate to a stop. This only works when you have two or more keyframes creating an animated 
effect. Select one or more keyframes, then choose Ease In, Ease Out, or Ease In and Out from 
the toolbar, depending on which keyframe you’re editing and the effect you want to create.
To change one or more eased keyframes to Linear: Select one or more keyframes, then 
choose Linear from the toolbar.
To change the interpolation of multiple keyframes: Select multiple keyframes by Command-
clicking or dragging a bounding box, and then click one of the four Bezier interpolation buttons in 
the Curve Editor title bar to simultaneously change the interpolation of all of them.
To adjust a Bezier handle: Drag the Bezier handle in any direction to alter the curve.

Methods of Cutting, Copying, Pasting, and Deleting keyframes:

To cut or copy, and paste one or more keyframes: Make a selection of keyframes and use the 
Cut (Command-X) or Copy (Command-C) key shortcuts. Then, move the playhead to where you 
want the first of the copied keyframes to start, and press Paste (Command-V).
To delete one or more keyframes from a curve: Select the keyframe(s) you want to delete and 
press Delete.

Curve Editor Controls

The Curve Editor controls (L-R): Curve Editor, Keyframe Editor, Parameters, Selection, Hand, Add Keyframe, 
Linear, Ease In, Ease Out, Ease In and Out, Detail Zoom, Full Extend Zoom, Zoom Slider, Expand, Option Menu.

Curve Editor: Click this icon to open the Curve Editor.

Keyframe Editor: Click this icon to open the Keyframe Editor.

Parameters: Opens a checkbox to turn on or off individual curve visibility. 
In addition, if you’ve added a keyframable Open FX or Resolve FX to the clip, 
you can select those parameters here.
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Pointer Mode: Returns to the standard mode where clicking on 
things with the pointer selects them.

Hand Mode: Lets you click and drag to navigate through the Curve Editor 
when zoomed in. Useful in highly detailed and complicated animations.

Add Keyframes: Turns the pointer into an Add Keyframe tool that will add a 
keyframe on any curve in the Curve Editor simply by clicking it.

Show Handle: Toggles the Bezier handle controls on or off.

Linear: Sets the curve to a direct linear progression from 
keyframe to keyframe.

Ease In: Sets the curve to gradually intensify the curve from 
the starting keyframe.

Ease In and Out: Sets the curve to gradually intensify the curve 
from the starting keyframe and gradually intensify the curve towards 
the ending keyframe.

Ease Out: Sets the curve to gradually intensify the curve towards 
the ending keyframe.

Detail Zoom: Zooms the Keyframe Editor in around the playhead position.

Full Extend Zoom: Zooms the Keyframe Editor out to show the 
range of the whole clip.

Zoom Slider: Lets you choose a custom zoom level for the Keyframe Editor.

Expand: Opens the Keyframe and Curve Editor in its own resizable window.

Option Menu: 

	� Display Time Ruler in Seconds: Shows the Time Ruler in HH:MM:SS:FF 
timecode format based on the timeline.

	� Display Time Ruler in Frames: Shows the Time Ruler as number of frames 
since the timeline start.

	� Snap Keyframes to Grid: When enabled in the Curve Editor, this snaps 
keyframe control points to the grid markings on the graph.

	� Show Curve Tooltips: When enabled in the Curve Editor, placing the 
pointer over a curve will show its track name and value at the given point.
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Keyframable Open FX and Resolve FX

 

The Open FX and Resolve FX can be adjusted in the Keyframe and Curve 
Editor by selecting it in Display Selected Parameters.

Keyframes added to Resolve FX parameters appear in both the Keyframe and Curve Editor. 
Using the Display Selected Parameters menu in the 3-dot option menu, you can expose 
individual keyframe tracks and curves for each keyframed parameter of an effect applied to a clip 
for smoothing, retiming, or editing.

Import Blackmagic Cloud 
Shared Folders to Media Pool
You can now import and sync Blackmagic Cloud Folders into the Media Pool. This allows you 
to connect to one or more cloud media folders and selectively download media from them to 
your local machine. Blackmagic Cloud Folders are online common storage folders that are not 
tied to a specific project. This lets you create a pool of commonly used media assets, such as 
title sequences, credits, bumpers etc., and share them online without having to import them 
separately into each individual project.

The Import Cloud Folder icon at the top of the Media Pool
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To link a Blackmagic Cloud Folder to your project:
1	 Sign into your Blackmagic Cloud account in DaVinci Resolve.

2	 Click on the Import Blackmagic Cloud Folder icon at the top of the Media Pool in any page.

3	 In the Blackmagic Cloud Folder dialog, click select to choose a Blackmagic Cloud Folder. 
The choices here will show any Blackmagic Cloud Folder that you have created, or someone 
else has shared with you. Click the Add button.

4	 In the Download Folder Location, select a file location on your local system that you want the 
media from the Blackmagic Cloud Folder to be stored in.

5	 Choose whether you want to sync proxies only, or sync proxies and used originals.

6	 Press Download to add the Cloud Folder to your Media Pool.

When you open the Blackmagic Cloud Folder in the Media Pool, it will be empty and 
populate one clip at a time as their clip names (not their media) are downloaded from 
the cloud. Also, the Blackmagic Cloud Folder is not actually linked to your project yet, 
it is only linked when the first media clip is “used.”

 

The Blackmagic Cloud Folder link dialog

A “used” clip is new terminology in DaVinci Resolve and simply means a clip that has 
been altered in any way inside the project. A clip can be used be by putting it on 
a timeline, certainly, but also includes other actions like applying a flag, altering its 
metadata, transcribing it, etc. Once a clip is used, its media will start to download to 
your local machine. Clips that are used are denoted by a red dot next to them in the 
Media Pool. Any unused clips will remain as virtual clips in the Cloud Folder until used. 
Once downloaded, clips in Cloud Folders can be used just like any other clip in the 
Media Pool.
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AI IntelliScript for Creating Timelines 
from Scripts (Studio Version Only)
DaVinci Resolve 20 has a powerful new AI powered IntelliScript tool, which uses the 
Transcription Engine to match and generate a timeline using an original script. This feature lets 
you quickly assemble rough cuts of scenes and even organizes multiple takes for you in the 
timeline. IntelliScript is smart enough to understand context, so if your actor ad-libs and uses a 
similar phrase rather than the exact phrase written in the script, it should still find it.

To Use IntelliScript to generate a timeline based on a script:
1	 Create a script file in plain text (.txt) format. IntelliScript will ignore simple formatting 

like character name and stage direction, and will only make its decisions based on 
spoken dialog.

2	 Transcribe all the clips you want to use for IntelliScript in the Media Pool by selecting 
them and right-clicking and choosing AI Tools > Audio Transcription > Transcribe. 

For more information on Audio Transcription, see the DaVinci Resolve Reference Manual, 
Chapter 40.

3	 Once transcription is complete, select all the clips you want to use for IntelliScript again, 
right-click, and select AI Tools > Create New Timeline Using IntelliScript.

4	 DaVinci Resolve will then prompt you to load the text script file. Press Open.

A simple text file script to feed into IntelliScript

When the process is done, IntelliScript will create a new timeline, and on track one, lay out the 
best clips in order based on the dialog in the script file. Any alternative takes are automatically 
placed on additionally created tracks that are disabled by default. Once the timeline is set up, 
you can review the best take on track one and preview alternative takes for specific regions, 
enabling and disabling them as needed.
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The IntelliScript results in the Timeline. It places the best takes on track one, 
alternative takes on separate tracks and disables them by default. Here we overrode 
its choices at the end and manually enabled what take we thought was best.

NOTE: IntelliScript chooses the “best” take by matching the spoken dialog only. It does 
not use any good take metadata or make any judgments based on anything other than 
dialog matching. 

AI Dialogue Matcher (Studio Version Only)
Dialogue Matcher allows you to match one piece of dialogue to another, matching tone, level, 
and room reverberance/ambience. This can help with situations where new recordings may 
not match the environment of existing ones. Using the AI Dialog Matcher to match room tone is 
particularly useful. The Dialogue Matcher is a fully automated tool that only requires the user to 
capture a tone profile from a clip and then to apply it to another.

Capturing a Dialogue Profile from a clip using the main menu
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To Use Dialogue Matcher:

1	 Select a reference clip whose dialogue you want to match, right-click, and choose 
Clip > AI Tools > Dialogue Matcher > Capture Dialogue Profile.

2	 Select the clip whose dialogue you want to change, right-click and choose 
Clip > AI Tools > Dialogue Matcher > Apply Dialogue Profile.

3	 You can enable or disable the Dialogue Matcher on a clip by right-clicking and 
choosing Clip > AI Tools > Dialogue Matcher > Enable.

4	 You can Remove the Dialogue Matcher on a clip by right-clicking and choosing 
Clip > AI Tools > Dialogue Matcher > Remove Applied Profile.

AI Music Editor (Studio Version Only)
DaVinci Resolve 20 supports seamlessly extending or shortening music to the length of your 
edit. The new AI powered Music Editor can be accessed in the Audio tab of the Inspector. You 
can enter a desired duration and press the Retime button in order to shorten or extend the clip to 
that duration. 

NOTE: Music Editor is an “intelligent edit” that works effectively with beat-driven music 
(pop, dance, etc.). It is not intended for free form, ambient, or non-beat-driven material. 

Music Editor does not use time compression/expansion or alter the pitch of the music, but 
instead uses editing techniques like a music editor might to fit the material to desired length to 
picture. It will look for logical places to create transitions based on whether you’re extending 
length (by repeating sections), or removing material, and attempt to use the ending or fade of 
the original composition if it times well. If the ending is abrupt, it’s up to you to manually create 
a fade out.

The Music Editor in the Audio Inspector
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To Use Music Editor to retime a music clip:

1	 Select the clip on the timeline you wish to retime. This clip does need to be 
beat‑driven music.

2	 In the Audio Inspector under AI Music Editor enter a new Target Length for the 
music duration you want. 

3	 Press the Adjust button.

4	 Alternatively, you can check the Live Trim box to use the trim tools to resize the 
clip and dynamically retime the music on the timeline. You can turn the checkbox 
off to return to normal editing (e.g., trimming) for that clip after the desired edit has 
been created.

Once the analysis is complete, four versions of potential edits you can use appear at the bottom, 
each with a different approach to the edit, numbered 1-4. Any subsequent editing can be done 
almost instantaneously. The edited pieces of music show indicators on the clip to show the 
portions where cuts and transitions occur.

The initial music is too long

 

The Music Editor has retimed the audio clip to match the length of the video. 
Note the jagged lines on the audio clip indicating where the original was cut. 
In the waveform you can see the end of the music is retained in the retimed clip.

TIP: While timings can be quite close, sometimes they may not be exact. If you need to 
get an exact timing after working with AI Music Editor, you might use the Elastic Wave 
tool on the Fairlight page and choose the algorithm for general purpose (music).

The edited clip is actually a specialized Music Editor clip, which allows you to further trim 
your edit. If you want to access the underlying edit, you can also right-click on the clip and 
decompose, exposing the edit points and any crossfades created. However, keep in mind that 
once decomposed, you can’t trim the length of the clip as an entity as each editing snippet is 
now a separate clip.
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AI Animated Subtitles (Studio Version Only)
A new set of Fusion title templates, called Animated, has been added to DaVinci Resolve 20. 
These templates can be added to subtitle tracks, allowing you to easily create animated subtitle 
effects. These effects work in conjunction with DaVinci Resolve’s transcription engine to match 
and highlight spoken audio with subtitle timing.

You can audition the prebuilt templates in the Animated section of the Titles tab, and, of course, 
using Fusion you can crate your own custom templates as well.

To animate your subtitles, simply drag the animated template from your Titles library 
on top of the header of the subtitle track. You can customize their parameters 
in the Inspector.

The Word Highlight animated template has been applied,  
highlighting each word in red as it is spoken in the clip.

AI Super Scale 3x 4x Enhanced 
(Studio Version Only)
For high quality upscaling of low resolution footage, Super Scale now includes 3x Enhanced and 
4x Enhanced modes. The enhanced modes let you choose specific values for Sharpness and 
Noise Reduction, rather than just relying on low, medium, and high settings. Super Scale works 
amazingly well when dialed in correctly, but remains one of the most computationally intensive 
tools in DaVinci Resolve, so you may want to work with proxies or optimized media if you have a 
lot of Super Scaled footage.

28DaVinci Resolve 20 Cut and Edit



AI Beat Detector Displays Music Beats
DaVinci Resolve Studio 20 can now automatically detect beats for a piece of music on the 
timeline and supports snapping to these beat marker locations. This can be especially useful 
when trying to make edits to the beat.

Note The Beat Detector will only work effectively with beat-driven music and 
with 4/4 or 3/4 time signatures at this time.

To detect beats, right-click on the timeline audio clip and select Detect Music Beats 
from the context menu. Once analyzed, the timeline clip displays beat indicator 
overlays that you can snap other timeline elements to.

A music track with the Beat Detector applied. The lined overlays match up with the beat of the music.

Optimized UI Layouts 
for Vertical Editing
Optimized layouts for vertical timelines and projects are now supported in DaVinci Resolve 20. 
When a vertical timeline or project is loaded, the UI automatically switches to a layout optimized 
for vertical viewers on the Cut, Edit, and Color pages. Loading a normal landscape timeline or 
project then automatically switches back to the original layout. No additional user intervention 
is needed. 

You can change this behavior in Preferences > User > UI Settings > Use optimized UI layouts 
for vertical video. Unchecking this box retains the normal horizontal layout, even for vertical 
video timelines.
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The UI now changes format to accommodate vertical video timelines automatically.

Custom Sort of Clip Thumbnails 
in the Media Pool
You can now manually reposition Media Pool clips in Thumbnail view, allowing you to group clips 
together in any way that visually makes sense to you. 

You can turn on Custom Sort by selecting Custom in the Sort menu in the Media Pool.
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Select Thumbnail view in the Media Pool, and from the Sort menu, select Custom. Then 
you can drag your thumbnails around in any order or grouping that you wish. If Snap to 
Grid is selected in the Sort menu, the icons will line up in neat rows and columns. Turn 
off Snap To Grid to enable freeform positioning. If two thumbnails are overlapping, the 
last one moved will show on top.

With Snap to Grid deselected, you can rearrange thumbnails in any way 
(even overlapping) and it is retained throughout the Media Pool on all pages.

The position of your icon thumbnails are persistent in the Media Pools across all pages 
in DaVinci Resolve. The positioning is also retained if you temporarily choose another 
sort order, and then return to the Custom sort.

New MultiText Tool with Text 
Layers and Easier Controls 
for Transform, Clip, and Wrap
Built on Text+, the MultiText tool in the Titles category gives you greater flexibility to add 
and format multiple text layers, all within the single tool. It introduces a Text List and a slight 
rearrangement of controls, prioritizing functionality based on editors’ needs.

The Text List serves as a master panel, displaying all created text layers. The list and controls 
remain available across Inspector tabs, allowing quick access to tweak both text and its 
properties at any time. Directly below the Text List, the Add Text buttons offer three commonly 
used layout types: Point, Text Box, and Circle, making it effortless to add your preferred 
input style.

When Text Box is selected, the newly added Wrap to Text Box and Clip to Text Box checkboxes 
can be found under Layout tab. With Wrap to Text Box selected, your text will automatically 
continue on the next line when it reaches the edge of the text box. When Clip to Text Box is 
selected it ensures that any text extending beyond the text box‘s boundaries is visually cut off, 
preventing overflow while keeping the excess content intact.

There is also a new Page tab, which allows you to add a custom-colored background 
behind the text layers.
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The MultiText tool in the Titles section lets you create multiple  
text layers and styles and composite them all within a single interface.

Subtitle Tracks Support 
Fusion Templates for Styling
In DaVinici Resolve 20, you can now style a subtitle track using a Fusion template. To style 
a subtitle track, just drag any Fusion title template from the Effects Library on the subtitle 
track header. The Fusion effects now override any track or per-caption styling applied to 
the track via the Inspector, allowing you to create fine-tuned text looks from the underlying 
Fusion compositions.

Using a Fusion template to create stylized subtitles
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Sync Specific Media Originals 
in Proxy‑Synced Cloud Projects
In Blackmagic Cloud projects where only proxies are being synced to Blackmagic Cloud, 
you now have the ability to sync originals for specific files in the Media Pool. This is useful in 
situations where you either need to upload or download originals for certain files, but not all 
of them. You can right click on the Media Pool clips you need the originals for and select Sync 
Original Media from the context menu.

You can select individual media proxies and download the original files for just those clips.

Split Photoshop PSD Layers 
into Individual Timeline Tracks
You can now right-click on an Adobe Photoshop document (.psd) in a timeline and select Split 
PSD Layers in Place to expand each layer of the file into its own track. The number of new tracks 
created will correspond to the number of layers in the file.

You can split Photoshop PSD layers into individual tracks by 
right‑clicking on them and selecting Split PSD Layers in Place.
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The results of splitting a PSD file

DaVinci Resolve reads and splits rasterized flattened layers, so some steps need to be taken 
when preparing the underlying PSD asset before import. Merging layers in Photoshop to create 
flattened layers is generally a manual process. The intention is to simplify the image structure, 
bake Photoshop-specific effects, and rasterize fonts to ensure compatibility with DaVinci Resolve. 
Here is a breakdown of the process:

Rasterize transparency and effects

If your layers/fonts contain effects like shadows or gradients, merging them can 
sometimes alter their appearance. Consider rasterizing before merging. To do this, select 
one or more layers, right-click and choose Rasterize Layer Style. This is recommended 
for text layers as well.

Merge and flatten similar layers

Arrange similar layers together and select the layers you want to merge. Right-click on 
the selected layers and choose Merge Layers (Cmd/Control+E) to combine the selected 
layers into one ‘flat’ layer. Depending on the complexity of the Photoshop document, 
consider using the option: File > Scripts > Flatten All Layer Effects.

Name layers

Rename the layers to describe the underlying image, effect, or element. Naming the 
flattened layers at this stage allows DaVinci Resolve to use the names in the split clips.
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Support for Alert Red 
Viewer Background Mode

To make it incredibly clear that you have issues with blanking, compositing, and other 
problems filling your frame, there is now an Alert Red option in the Timeline View 
Options > Viewer Background settings. Selecting this option fills any transparent part of 
the frame with the brightest, most saturated red our engineers could devise.

The Alert Red Viewer background makes it blindingly  
obvious where you have transparency issues in your frame.

Improved Transcription Quality and 
Support for Additional Languages
DaVinci Resolve 20 has improved its transcription quality and added transcription and automatic 
subtitling support for many more languages. Because all these language models are quite large, 
the Extended Transcription Language Support is one of the first tools to use the new Extras 
Download Manager, which allows you decide what tools you need on your system.

To enable these additional languages:
1	 Go to DaVinci Resolve > Extras Download Manager.

2	 In the Extras Download Manager, click the Download icon next to the Extended Transcription 
Language Support package.

3	 Once downloaded, go to the Subtitles and Transcription section of the Project Settings. and 
check the Enable Extended Language Support box.
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The current transcription language options now include: Afrikaans, Arabic, Armenian, Azerbaijani, 
Belarusian, Bosnian, Bulgarian, Catalan, Chinese, Croatian, Czech, Danish, Dutch, English, 
Estonian, Finnish, French, Galician, German, Greek, Hebrew, Hindi, Hungarian, Icelandic, 
Indonesian, Italian, Japanese, Kannada, Kazakh, Korean, Latvian, Lithuanian, Macedonian, Malay, 
Marathi, Maori, Nepali, Norwegian, Persian, Polish, Portuguese, Romanian, Russian, Serbian, 
Slovak, Slovenian, Spanish, Swahili, Swedish, Tagalog, Tamil, Thai, Turkish, Ukrainian, Urdu, 
Vietnamese, and Welsh.

Please note that some of these languages are still in beta.

Smooth Cut Supports AI Speed Warp
The Smooth Cut transition in DaVinci Resolve 20 now automatically uses our AI-powered Speed 
Warp interpolation for extremely clean transitions for edits with jump cuts. AI Speed Warp is 
automatically enabled when you apply Smooth Cut transitions to edits. In situations where you 
would like the previous Smooth Cut behavior, uncheck the AI SpeedWarp checkbox in the 
Transition tab of the Inspector.

Export Audio Transcriptions with 
Speaker and Timecode information
In DaVinci Resolve 20, when you export a transcription, the resulting text file will now include 
Speaker Name and Timecode information for each speech block. This useful information will 
make searching and navigating transcriptions much easier.

Transcripts now include speaker and timecode information for dialog blocks.
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Transcription Exports Improvements
The transcription export has also been improved regarding the timing of phrase and 
sentence breaks.

Editable Spatial Video 
Metadata in the Inspector
If you are using Apple Spatial Video clips, you can now adjust the Baseline, Horizontal Field of 
View, and Disparity Adjustment parameters of the clips in the File Inspector.
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Cut Page
Certain features in DaVinci Resolve 20 are native to the Cut page, such as a new Voiceover and 
Prompter tool, and now Live Overwrite capability without a Speed Editor.

Voiceover Tool
The Cut page in DaVinci Resolve 20 has a new dedicated voiceover and teleprompter interface, 
easily accessible in the Viewer by clicking on the Voiceover icon. The Voiceover tool makes it 
simple to record perfectly timed scripts directly into the Cut page timeline. You can even apply 
Voice Isolation and the Dialog Leveler on the fly to get great results, even with substandard 
microphones and recording environments.

Recording a VO audio track directly into the Cut Page timeline using the Voiceover tool

Using Voiceover on the Cut Page
At its most basic, you can quickly “punch in” a recording using only a microphone and an In 
point, but the Voiceover tool has a variety of features to make the process more precise and 
repeatable, including teleprompter support and AI-based audio tools. Below is a sample setup 
that makes the most out of the Voiceover features on the Cut page.

1	 Connect an external microphone and headphones to your computer, then format 
a plain text (.txt) script for your VO.

2	 Press the Voiceover tool icon in the Viewer.

3	 In the Voiceover settings, select your microphone interface.
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4	 Select the Audio Track you want the voiceover clip to be recorded to. By default, 
the Cut page creates a new track called VO.

5	 You have additional options for countdowns and to select the file folder that your voice 
recordings are saved into.

6	 Determine where in the timeline this voiceover is needed. In a simple setup, just place the 
playhead at the location you want the VO to start. You can also set an In point in the timeline 
to serve as a cue point that the Voiceover tool returns to for subsequent takes.

7	 You can optionally turn on the Voice Isolation and Dialog Leveler if you’re recording in a 
substandard audio environment (for example, directly into your laptop microphone in an 
office environment) to clean up your audio as you record it.

8	 Click the Record button to start the teleprompter and recording to the selected track. The 
interface will change to red to let you know you’re “on the air.”

9	 Click Stop to end the recording. The playhead will automatically snap back to your start 
position, so you can then play your new voiceover in place.

10	 If you need to try again, press the Cue button to automatically return to the In point, and 
press Record again to give it another take. The new voiceover will automatically overwrite 
the old take on the timeline. However, all of your previous VO takes will still be saved in the 
Media Pool, if you want to go back to them.

Using the Prompter

The Voiceover tool has a build in Prompter toolset that lets you import a text (.txt) 
script, and during recording the text scrolls over the picture for accurate voiceover 
performance and placement.

The built-in Prompter in the Voiceover tool

39DaVinci Resolve 20 Cut Page



To use the Prompter while recording voice over:

1	 Open and set up the Voiceover tool, as described above.

2	 In the Script settings, Enable the Prompter Overlay, and Load the Script File. 
You have additional settings for how the script is formatted in the Viewer.

3	 You can set In and Out points on the timeline to mark the VO range for the 
teleprompter. The teleprompter will then adjust its speed automatically to start 
scrolling at the In point, and end at the Out point. By default, the script scroll 
length will cover the entire timeline, if no in or out points are set.

4	 When you press Record, the text will scroll over the image while your voiceover is 
being recorded.

Voiceover Settings
The Voiceover tool has several optional settings to fine tune your VO session.

Clicking on the Voiceover icon (red) opens the Voiceover toolset at the bottom of the Viewer.

Audio Input: Select which computer interface your microphone is connected to.

Record Track: Select which audio track in the timeline you want the VO to be recorded to. 
By default, the Cut page creates a new track labeled VO, but you can manually override it 
to another track in this setting.

Monitoring

Timeline and Audio Input: Lets you hear both the timeline audio and your 
voice input while you’re recording.
Audio Input: Lets you hear your voice input only, and mutes the timeline 
while you’re recording.

No Countdown: No visual countdown appears; when you press Record, start talking.

3 Secs Countdown: Puts a three second visual countdown on the Viewer before the 
recording begins, to allow a little time to get ready first. This is a visual cue only; there are 
no audio beeps.

5 Secs Countdown: Puts a five second visual countdown on the Viewer before the 
recording begins, to allow a little time to get ready first. This is a visual cue only; there are 
no audio beeps.

Voiceover Recording File Location: Select where your new audio files are saved to.
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Script Settings

Enable Prompter Overlay: Turns on or off the text overlay for the loaded script.

Load Script File: Opens a file selector to choose a text file to load into the prompter.

Clear Script File: Removes the text file from the prompter.

Font Size: Lets you choose the font size of the on-screen text.

Line Spacing: Lets you choose the line spacing of the on-screen text.

Side Margin: Lets you choose how big of a margin to use for the on-screen text.

Background Opacity: Lets you choose the transparency level of the on-screen text.

Play Prompter Without Video: This decouples the text script from the video, allowing you 
to record a VO free form, without having to worry about timing constraints. It also enables 
the following options:

	� Read Speed: Adjust the scrolling speed of the text. You can set a speed percentage 
or manually enter a specific duration.

	� Set Speed Using Search Dial: If you are using a Speed Editor, you can use the 
search dial to adjust the scroll speed of the text on the fly, similar to professional 
teleprompter systems.

Audio Meters: A miniature set of audio meters shows your microphone’s audio levels.

Audio Input Only: A toggle to choose between hearing your voice only, or your voice plus 
all the timeline audio while you’re recording.

Cue: Snaps the playhead back to the initial record In point.

Record: Starts the audio recording into the timeline.

Stop: Stops the audio recording.

Voice Isolation: Activates the Voice Isolation effect as you are recording, to minimize any 
background noise.

Dialog Leveler: Activates the Dialog Leveler effect as you are recording, to keep a constant 
volume for your track.

Stereo Fixer: Activates the Stereo Fixer effect as you are recording, to eliminate common 
channel errors involved in translating between mono and stereo sources.
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Ripple Trimming Now 
Available on Secondary Tracks
Before DaVinci Resolve 20, ripple editing in the Cut page was only available on the primary track. 
Now you can use the Cut page’s ripple editing on secondary tracks as well, even when there is 
no underlying video on the primary track.

We want to delete the selected clip and close the gap,  
even though our clips are on a secondary track.

Previous to DaVinci Resolve 20, deleting the clip would  
leave a gap, even if the ripple trimming was turned on.

As of this release, you can now delete a clip  
and ripple the timeline, even on a secondary track.

Multi Views Show Previously Used 
Camera Angles in a Replay Session
Previously used Replay angles are now indicated with a blue border for the duration of the 
replay. To clear the indicators, press Dump Session or exit Replay.

Tapping Time Buttons Enables Camera 
Button Presses to Preroll Replays
You can control the preroll time of a camera before a switch by pressing a Time button. 

Press a Time button (2 sec -7 sec) to select it. The Time LED lights up to indicate the preroll 
mode and duration. Press the Time button again to deselect it. With a Time button selected, 
press the Camera button to preroll for the set time and then perform the switch.
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Automatically Resync Media 
Files Supports Still Images and 
Frame Sequences
Syncing Media Pool bins with File System folders using the Automatically Resync Media Files 
command now supports syncing still images and frame sequences. Previously, it was limited to 
video and audio clips only.

Live Overwrite from Source and 
Source Tape Using Edit Keys and 
Search Dial on Speed Editor
In DaVinci Resolve 20, new Live Overwrite functionality has been added to the Editing Tools keys 
of the Speed Editor. Pressing and holding on each of the Editing Tools keys, then rotating the 
Search Dial will now perform various Live Overwrite operations using the material in the Source 
and Source Tape on the Cut page.

NOTE: These new features are all “Press and Hold” operations. If you simply tap on a 
key, it will perform the originally listed function instead.

With the selected media in the Source Viewer or Source Tape, press and hold the following 
buttons and use the search dial to paint the source clip in.

	� SMART INSRT: Live paints the source clip at the smart indicator, and ripples the timeline 
appropriately.

	� APPND: Live paints the source clip at the end of the timeline.
	� RIPL O/WR: Live paints and replaces the clip in the timeline with the source and ripples the 

timeline appropriately.
	� The initial button press grays out the original timeline clip.
	� When you rotate the dial, the original clip is replaced with a gap of the same duration, and 

the source clip is painted into the gap.
	� If the painted clip is longer than the original, the timeline ripples out and creates space.
	� On releasing button, any remaining gap where the original clip was is removed. The timeline 

then ripples in to adjust.
	� PLACE ON TOP: Place source clip on top of current timeline clip at playhead with live paint. 

You can paint over multiple adjacent clips for longer inserts and roll back the search dial to 
restore before releasing.

	� CLOSE UP: Places the source clip with smart zoom on top with a live paint. You can paint 
over multiple adjacent clips for longer inserts.

	� SRC O/WR: Places a clip on top, matching the timeline clip’s timecode. If no matching 
timecode can be found, the timeline playhead glows red as an indicator and no edit occurs. 
You can paint over multiple adjacent clips for longer inserts.

To undo the live paint operations and restore the original, rotate back to start and then release 
the button.
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Live Overwrite Camera Angles 
from Multi Source and Sync Bin 
Viewers with a Mouse Drag
If you don’t have a Speed Editor, you can still use the paint on functionality of Live Overwrite on 
multicam material with your mouse.

By clicking and dragging on camera angle 1 in the Viewer, the angle is 
“painted on” to the timeline for the same duration as the drag. You can 
continue to click and drag multiple angles for a quick multicam production.
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To do so, open all your multi camera angles, either in the Sync Bin or the Multi Source viewers. 
Then simply click on the angle you wish to use, then drag horizontally in the image to live paint 
the angle on the timeline at the playhead position. Then click on another angle and drag it to 
paint on the next camera. 

Because of the unique syncing nature of the Sync Bin that keeps all your footage locked 
together, you can very quickly create an entire multicam production just using simple 
mouse drags.

Trim with Safe Edit
Editing in the Cut Page timeline can be fast and furious, and if you wish to avoid accidentally 
overwriting an adjacent clip while trimming, you can turn on “Trim with Safe Edit” in the 
Timeline options.

With this mode enabled, you can trim and extend an edit point as normal until it 
intersects another clip. When the trim cursor reaches the next clip’s bounds, it stops the 
trim and shows a small timer on the cursor rather than pushing on with the overwrite. 
If you actually do want to overwrite the adjacent clip, continue dragging with the mouse 
or rotating the Speed Editor dial to override the timer and overwrite the adjacent clip 
with the trim operation.

In the Timeline options, select Trim with 
Safe Edit to prevent accidental overshoots.

 

The safe edit cursor stopping you 
from overwriting the subsequent 
clip; continue dragging the clip 
to perform the overwrite anyway
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Metadata Display Palette 
in the Media Pool
When in the Source Tape or Source mode in the Viewer, a small tag icon becomes available 
directly to the left of the search bar in the Media Pool. Clicking on this icon activates the 
Metadata Display Palette at the top of the Media Pool. The display shows basic information about 
whatever clip is selected, in order for you to quickly review the details about selected clips.

Next to the search bar in the Cut page Media Pool is a small tag icon (circled red) 
that opens the Metadata Display Panel at the top of the Media Pool.

The information on the display includes, Camera Name, Scene/Shot/Take, 
Frame Rate, and Resolution.

Copy, Paste and Remove 
Attributes from Timeline Clips
You can now copy, paste, and remove attributes from clips in the Cut Page timeline, similar 
to how the Edit page operates. To do so, right-click on the clip in the timeline you want to get 
the attributes from, and select copy. Then select the clip you want to modify on the timeline, 
right-click and select Paste Attributes. A check box menu will appear, allowing you to select the 
specific attributes that you want to paste.

You can cut, copy, and paste clip attributes from the 
Cut Page timeline, using the controls in the context menu.
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Dynamic Trimming Using JKL Controls
The Edit page’s Dynamic Trim mode using the JKL controls on the keyboard has been added to 
the Cut page, for quick keyboard trimming.

The Dynamic Trim mode lets you resize selected edit points and clips using the JKL transport 
control keyboard shortcuts. This means that you can make an appropriate selection in the 
Timeline, then trim them during playback, all while monitoring audio and watching the video.

Trimming while viewing the selected clip or edit point playing back has the advantage of letting 
you get emotionally involved in what you’re watching, as well as experiencing the timing of a clip 
as it plays, in order to help you get a better feel for how, exactly, you need to trim a particular cut.

While you’re dynamically trimming, you see the same two-up display, the same 
Timeline overlays, and the same dynamically updating timeline that appear when 
you use the Trim tool with the mouse. The only difference is that you’re trimming 
while your program plays.

The playhead turns yellow to show you are in Dynamic 
Trim mode. The green highlight shows that only the outpoint 
of the first clip is active. Using the JKL keys on the keyboard 
will then shift that edit point forwards or backwards
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To use Dynamic Trim mode to dynamically trim one or more selected clips or edits:
1	 Select one or more edit points on the timeline that you wish to trim. Otherwise, the edit 

closest to the smart indictor will be selected for trimming.

2	 Press W to enter Dynamic mode, or select Trim > Dynamic Trim Mode, and click the 
Dynamic tool in the toolbar. Once you’ve entered Dynamic Trim mode, the playhead tool 
turns yellow to serve as a constant reminder that in this mode all you can do is trim clips.

3	 The edit point will be highlighted in green to show which edges of the clip are selected 
for trimming. Press U to toggle through the available edit point types, or select 
Trim > Edit Point Type.

4	 Use any combination of the JKL keyboard shortcuts to initiate playback 
and trimming, including:
	� J+K or K+L to trim in slow motion, with slow motion audio playback
	� Pressing K while tapping J or L to trim a frame at a time
	� Pressing J or L to trim with real time playback
	� Pressing J or L repeatedly to trim in fast-reverse or fast-forward, at a variety of speeds

5	 As you dynamically trim, all audio clips in all audio tracks will play back as the playhead 
scrolls across them, so you can hear your entire mix as you’re trimming.

6	 After you’ve made a trim, pressing the Spacebar initiates Play Around Current Selection, so 
you can see how well that trim plays. In Dynamic Trim mode, the Spacebar only executes a 
Play Around Current Selection operation, rather than play forward as it usually does.

7	 When you’re finished, you can use the Up and Down Arrow keys to move both the selection 
and playhead to another edit point or clip you’d like to trim, or you can press W again to 
toggle Dynamic Trim mode off.

You always want to be sure to turn Dynamic mode off when you’re done, because otherwise 
using the JKL keys will continue trimming selections whenever one or more edits or clips are 
selected, instead of playing the Timeline.

Full Featured Audio Mixer
The Cut page can now show a full Audio Mixer, with access to all the tracks and busses of your 
mix, in addition to shortcuts to any audio Track FX, Dynamics, and Equalizer tools. To enable the 
Audio Mixer, select the Mixer tab at the top of the Cut page.

The Audio Mixer in action during Cut page playback
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A unique feature of the Cut page Audio Mixer is the ability to expand it fully using the 
Expand icon in the upper left of the Mixer. This will replace the whole lower timeline with 
the Mixer, giving you plenty of room to monitor complex audio compositions, while still 
being able to access the editing functions of the upper timeline.

The Audio Mixer expanded, allowing you to see all audio  
tracks while still editing in the upper timeline of the Cut page.

Clip Context Menu Actions 
for the Mini Timeline
In the Cut page, right-clicking on a clip in the upper mini timeline will now open a context 
menu, allowing you to perform the same actions as right-clicking on a clip in the Cut page’s 
main timeline.
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Edit Page
Certain features in DaVinci Resolve 20 are native to the Edit page, such as Dual Timeline Editing, 
and the new Multicam SmartSwitch.

Voiceover Tool with 
Record and Monitor Options
In DaVinci Resolve 20, both the Cut and Edit pages have the ability to record voiceover directly 
to a track in the timeline using a simplified interface. For serious and precise ADR work, the ADR 
toolset in Fairlight will be more appropriate, but for simple VO and scratch tracks, the Record 
Voiceover tool is quick and convenient.

To open the Record Voiceover tool, select Timeline > Record Voiceover, or select the Voiceover 
icon (the small microphone) on the Timeline toolbar.

The Record Voiceover tool

To Record Voiceover

1	 File Name: Type in a descriptive file name for the new Voiceover file or just use the 
default name.

2	 Audio Input: Choose which audio interface on your computer your microphone is 
connected to.

3	 Record Track: Choose the audio track in the timeline you wish your voiceover track to 
be recorded to. Or select Auto to have DaVinci Resolve choose for you based on your 
current track layout.

4	 Then adjust the playhead on the timeline where you want the audio to start.

5	 Click the Record Icon to start recording directly to the track.

6	 Click the Record Icon again to stop the recording.
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When the recording stops, the playhead will automatically snap back to its original starting 
position for you to either play back the voiceover clip in place or to instantly record a new take 
by simply clicking on the Record Icon again. This new take will automatically overwrite the 
previous clip on the track. However, all previous takes will still be available in the Media Pool.

You can choose additional options in the 3-dot option menu of the Voiceover tool.

Input Monitoring: Turning this option on will playback the microphone audio as it’s being 
recorded, albeit with some lag. This allows the voiceover artist or the audio engineer the 
ability to hear the audio as it’s being recorded. Selecting this option will make a Mic Monitor 
Level slider appear in the main Voiceover tool, which allows you to control how loud the 
playback will be in the headphones.

Enable 3 Seconds Countdown: Turning this option on will present a visual three second 
countdown in the Timeline Viewer before the recording begins, allowing you talent a 
little time to get ready to speak. There is no audio beep for this countdown; it is a visual 
indicator only.

Mute Timeline Audio While Recording: Selecting this option will mute all audio tracks on 
the timeline while you are recording, so you do not hear any other sounds that could be 
distracting. If you want to mute just some of the tracks, you can do that manually using the 
Mute buttons in the audio track timeline header.

Stereo Input: Selecting this option will record to a stereo track instead of mono, if you’re 
using a stereo microphone.

Hide Options: Selecting this option will remove the File Name, Audio Input, and Record 
Track fields from the Voiceover tool, leaving only the Record icon to click on or off. This is 
useful if you don’t want your voiceover talent to accidentally change your settings.

AI Multicam SmartSwitch 
for Automatic Angle Switching
DaVinci Resolve 20 has a new AI-powered multicam tool called Multicam SmartSwitch, which will 
analyze all multicam camera angles and automatically cut to the most appropriate angle, based 
on who is the active speaker. Multicam SmartSwitch doesn’t just use the audio track to determine 
which angle is best but includes other video related traits, such as lip movement in the frame, 
and if the shot is a wide or close up. Trained on thousands of hours of multicam footage, 
Multicam SmartSwitch is great for giving you a good first pass and letting you finesse the rest.

Selecting a multicam clip to be used with Multicam SmartSwitch
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To use Multicam SmartSwitch to automatically cut your multicam clip:

1	 Create a multicam clip in the Media Pool of all the individual camera angle clips.  
For more information on creating multicam clips see DaVinci Resolve Reference 
Manual Chapter 42. 

2	 Edit the multicam clip into the timeline.

3	 Right-click on the multicam clip, and select Multicam SmartSwitch 
from the context menu.

4	 Select the appropriate settings and parameters from the Multicam 
SmartSwitch tool.

5	 Click Analyze.

Multicam SmartSwitch analyzing the multicam clip

At this point, Multicam SmartSwitch will analyze all your video angles and audio tracks 
and choose what it thinks the best angle is under the circumstances. This can take 
quite some time, depending on the length and number of cameras angles used in the 
multicam shoot.

Multicam SmartSwitch finished cut on the timeline

When it is finished, you will have a fully cut version of your multicam clip available in 
the timeline. If you don’t like a choice that Multicam SmartSwitch made, you can easily 
switch the camera angle by right-clicking on it and selecting a new one from the 
Switch Multicam Clip Angle context menu, or using the standard trim tools to change 
the edit point.
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The Multicam SmartSwitch tool

Multicam SmartSwitch Settings
You can set parameters for the Multicam SmartSwitch tool that modifies how it 
makes its cut decisions.

Angle Switching: Adjusts the timing of the edits.

Minimum Edit Duration: Sets the minimum length of an edit. Regardless of what happens in 
the cut, Multicam SmartSwitch won’t change angles before the end of this duration.

Edit Change Delay: This lets you set the amount of time between the person speaking and 
the edit changing.

Wide Angle Setup: Just like a technical director, Multicam SmartSwitch will tend to use wide 
angles to cover things like people talking over each other and silences. You can tweak those 
settings here.

Automatically detect wide angles: Check this box to have Multicam SmartSwitch 
automatically choose what it considers to be wide shots.

Wide Angle: If you have a specific wide shot you want to use for coverage, you can 
manually select it here.

Wide Angle Frequency: How often should Multicam SmartSwitch cut back to the wide shot. 
Choices are Low, Medium, and High.

Use wide angle for intro and outro: Check this box to open and close the multicam clip on 
a wide shot.
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Use wide angle for silence: Check this box to go back to the wide shot when no one 
is speaking.

SmartSwitch Setup: Determines what media types to use for the analysis.

Switch: You can choose for the cuts to be Video Only, or cut Video and Audio 
tracks together.

Quality: Lets you choose the tradeoff between Faster (speed) and Better (accuracy).

Use Audio Only Fast Analysis: Check this box to use an analysis that uses only the audio to 
make its decisions, rather than analyze the video as well. This runs much faster and is only 
available in certain modes.

Source Tape in the 
Edit Page Source Viewer
The Cut page’s Source Tape is now available in the Edit page Source Viewer. To enable it, simply 
select a bin and then click on the Source Tape icon in the upper right of the Source Viewer, or 
press Shift-Q.

You can now edit using the Source Tape in the Edit page. To do so, 
click on the Source Tape icon in the Source Viewer (circled red).

Using this option, every single clip in the currently open bin, and any subfolders in that bin, of 
the Media Pool is shown in the Source Viewer as a “stringout” in the scroll area at the bottom of 
the Viewer. In the scroll area, each clip appears one after the other in a long strip, with the order 
determined by the sort order. This makes it easy to scrub through a whole collection of clips 
while you’re figuring out what you want to use. As you play through, whichever clip the playhead 
intersects is selected in the Media Pool, so you know which clip you’re looking at, and you have 
the ability to set In and Out points for any clip in the Source Tape. 

For watching and reviewing a large amount of footage, the Fast Review button is also now 
available in the lower left of the Source Viewer. Pressing this button will automatically adjust to a 
faster playback speed, depending on the length of the clip being viewed in the source tape.

For more information on using the Source Tape, see the DaVinci Resolve Reference 
Manual, Chapter 28.
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View and Edit Timelines 
in the Source Viewer
You can now work on two timelines simultaneously in the Edit page, one loaded in the 
Source Viewer and one in the Timeline Viewer. This allows you to easily compare two 
timelines or copy content between one timeline to another.

Enable Display Stacked Timelines in the 
timeline view options to use dual timelines

To get the best use from this feature, you should first enable Display Stacked Timelines in the 
Timeline View Options icon in the upper left of the timeline. Enabling this view will allow each 
timeline to appear in its own tab, and the Viewer will automatically switch focus, depending on 
which tab is selected. 

Then, in order to load a timeline into the Source Viewer, right-click on a timeline in the Media 
Pool and choose “Open in Timeline with Source Viewer.” The timeline will appear in the Source 
Viewer and as a new tab with the name and playhead turning blue to help you keep track of 
what timeline is in what viewer. The timeline in the Source Viewer is read only. You can switch 
between the timelines by clicking on the tabs, pressing Q or by clicking in the appropriate viewer.

You can change the timeline that appears in the Source Viewer either by right-clicking another 
timeline in the Media Pool and selecting the “Open in Timeline with Source Viewer” option, or by 
selecting one of the timelines in the dropdown menu at the top of the Source Viewer.

A dual timeline editing setup, with the Silent Natural timeline in the Source Viewer (blue), and the 
FX timeline in the Timeline Viewer. Switching tabs automatically focuses the appropriate viewer.
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You can perform standard Cut and Copy operations from the read-only Source timeline to the 
actual timeline, as well as drag from the Source Timeline Viewer (left) into the Timeline Viewer 
(right) to make an edit.

There are also keyboard shortcuts that make focusing 
between viewers that much quicker:

•	 To toggle between the Source and Timeline Viewers, press Q.

•	 To turn on and off the Source Timeline view, press Option-Q.

TIP: You can also right-click on a normal media clip and select Open in Timeline with 
Source Viewer to load that clip into the viewer as a timeline. These “timelines” will be 
read-only, but will otherwise allow the same timeline to timeline editing operations 
currently possible. This mode is useful for very long clips, like interviews.

Selecting a Single Reference 
Audio Track for Multicam Clips
Multicam clips in DaVinci Resolve 20 now support the use of reference audio sources. During the 
creation of the multicam clip, select Reference Audio/Angle 1 in the Multicam Audio selector. 

This selection automatically identifies the first audio-only angle and sets it as the reference 
audio for all the other angles. For multicam setups without an audio-only angle, the first angle is 
automatically used as the reference audio for the multicam clip. When performing multicam cuts, 
you can access the underlying channels in the reference audio angle by Command right-clicking 
on the clip, similar to Source Audio multicam clips.

Setting up the Reference Audio track in a multicam clip
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Matching Playhead Position in 
Compound Clip Opened from Timeline
In a nice quality of life improvement, DaVinci Resolve 20 now retains the relative playhead 
position in a compound clip opened from the timeline.

Timeline Settings from Timeline 
Tab Context Menu
You can now access the Timeline Settings from a tab in a Stacked Timeline view, by simply 
right‑clicking on the tab and choosing Timeline Settings from the context menu.
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Fusion
Fusion has received significant updates in DaVinci Resolve 20, including a Deep Image 
compositing toolset, along with Multilayer pipeline support. 

Deep Image Compositing Toolset
Fusion now supports a subset of tools to load, utilize, and save deep image data. Deep image 
data, particularly in formats like OpenEXR, stores multiple samples per pixel to represent data 
for objects at different depths in the same pixel. The Fusion Deep Image toolset can utilize this 
valuable information to layer complex 3D renders, particularly where multiple objects overlap, 
and integrate them with rendered 3D scenes. 

The following tools can be found in the Deep Image subcategory with a d-prefix:

•	 Image to Deep: The Image to Deep node has an input for a 2D image. When 
connected, the image is given deep image data and can be composited in a deep 
environment via the dMerge node.

•	 Deep to Image: Deep to Image node converts deep data into a 2D image by 
flattening its depth samples. This outputs the deep composite ready for traditional 2D 
compositing.

•	 Deep to Points: Converts Deep images into a 3D point cloud. This tool is useful 
for visualizing depth samples and offers a way to see elements in Z when 
incorporating elements.

•	 dCrop: Crops Deep Image samples using specified min and max depth values. Also 
crops pixels with an Input mask.

•	 dHoldout: Uses a foreground Deep Image to occlude background Deep Image 
samples, either by removing them or computing the value after occlusion.

•	 dMerge: The dMerge node combines multiple data streams, merging their depth 
samples for seamless compositing. This tool has numerous inputs, similar to the 
Merge 3D tool.

•	 dRecolor: Combines Deep Image data with an RGB (multi-layer) image. This node has 
two inputs, one for Deep/depth and the other for Color. Use this node to recolor Deep 
Image samples with 2D RGB values.

•	 dResize: Resize a Deep Image‘s width and height.

•	 dTransform: The dTransform node allows you to adjust spatial positioning of deep 
image data while preserving its depth samples. Scale and translate DeepImages, 
including the sample Z values.

•	 Renderer3D: Can output deep image data.

•	 Loader and MediaIn: Can import deep image data EXRs.

•	 Saver: Saver can export deep image EXRs.
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All deep compositing tools (outside of Image to Deep and Deep to Image) can 
automatically convert 2D image inputs to a deep image.

Note that deep compositing requires a linear colorspace. Once merged, users can 
convert the results into their desired colorspace. 

Multi Layer Pipelining for OpenEXR, 
PSD, and Stereoscopic 3D
Fusion can now intelligently handle multi-layer image workflows with support for EXR, 
Stereoscopic 3D, and PSD assets. Users can see a list of layers on the Fusion viewers and 
interact with layers in each node in the Settings tab in the Inspector. As this layer structure is 
retained throughout the toolset, this means you can isolate a tool to work on an individual layer, 
while still passing through the other layers unmodified.

Viewer
When loading a multilayer file, you can preview specific layers in the Viewer and select a layer 
from the dropdown list. Files without layer support will show only a ‚default‘ option from the 
dropdown menu.
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Using the Layer dropdown in the Viewer to select just the Asteroids layer from a multilayer file for viewing

Nodes and Inspector
In the Settings Tab you’ll find a Layer category where you have access to a number of controls to 
affect certain layers and to control layers from each tool input.

Process Layers: Select the layer to process for effects from:
	� Default Layer (default) – to apply the effect on the base/unnamed layer, 

not affecting other layers.
	� All Layers – to apply the effect on all available layers.
	� Custom – choice of other available layers to apply the effect on, 

not affecting other layers.

Input Layer: The Input Layer lists all layers available from the upstream node of the 
default input. The selected layer can be used by the current tool or further down the 
node tree in isolation.

Effect Mask Layer: If the tool has an Effect Mask input, this control lists the available layers 
that can provide mattes for the tool.

60DaVinci Resolve 20 Fusion



Connecting the multilayer file both directly to the BrightnessContrast Effect Mask (blue arrow) 
in addition to its input, allows you to quickly create perfect masks of any layer in the file.

Tools with other named inputs (like Image) can show additional layer controls with a 
corresponding name (like Image Layer).

Input Layer Controls
For optimal performance, Fusion tools request only the processed layers from each input. 
The Input Layer, Effect Mask Layer, Image Layer and other input layer controls allow the user to 
customize this behavior. In each input control, you can select Auto, or Match, or select an explicit 
layer value to map:

	� Auto: (Default) Requests the layer selected in the Process Layers selection. If the layer does 
not exist, the tool falls back to the default layer.

	� Match: Requests the layer selected in the Process Layers selection. If the layer does not 
exist, the tool shows a failure.

	� Explicit Layer Selection: Requests the explicit layer selection from one of the listed layers. 
This isolates the specific layer for use in the current tool or further down the node tree.

For Fusion plugins, the Process Layer and input layer controls are automatically 
generated in the Inspector‘s Settings tab. Creators of plugins can decide to define and 
place the controls explicitly in another place, similar to how the MultiMerge places the 
controls in the main controls section.

Some Fusion tools include controls to handle additional layer based decisions. 
For example:

•	 The Renderer3D shows a new Eye control > Layers option when using a stereoscopic 
camera, allowing the left and right eyes to be output as individual layers.

•	 When combining multi layered sources using composite nodes (e.g., MultiMerge), 
Channel Booleans, or a MatteControl, the Settings tab has additional controls to select 
Background or Foreground options to isolate and combine the selected layers.

•	 The Combiner tool can be used to create custom layers. Set the Mode to Layer. 
This exposes layer name fields, allowing you to name the new layers.
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Vector Warping Toolset for 
Image Patching and Cleanup
You can use the Smart Vector Warping 2D imaging toolset to map and warp a reference frame 
to all the other frames in the sequence. This is useful in face replacements, digital makeup, sign 
replacements, etc. to track and warp assets in tandem with the background. At its simplest, you:

	� Apply VFX changes—make-up, face paint, scars, black eyes—on one frame,
	� Ensure the areas of the reference frame are visible in the frames you are tracking,
	� Add Vector Warp, set reference frame, select Generate + Texture Map, and track the 

changes to the sequence using optical flow.

Vector Warp
The Vector Warp node has a main image input sequence (the background) and the map 
input image (a still to be warped). The output is an RGBA image and may contain extra motion 
vector channels (Vx, Vy. BVx, BVy) with forward and backward tracking information for use in 
downstream tools.

Inspector Controls:

Reference Frame: Set the reference frame for the Main sequence that the Map 
overlay was created for.

	� Use the Set Frame button to use the current frame as reference.

Operation: Choose from:
	� Generate to create a warp map from the reference frame to the current frame, saved in 

the vector channels.
	� Generate + Texture Map to create a warp map from the reference frame to the current 

frame, and warp the map frame.
	� Texture Map to warp the map frame from a previously generated texture map 

from input.
	� Unmap to freeze the map at the reference frame and reverse warp the main current 

frame to resemble the reference frame.

Smooth UV: Set a non-zero value to smoothen tracking anomalies and jitter with 
neighboring frame warp maps.

Grid Overlay: Display the warping as a Viewer overlay.

Merge Over: Display the composited map image on the main image sequence.
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Vector Transform
Allows custom transforms on the vector channel information, allowing tracking information to 
be resized, rotated, and translated to be applied on another image or sequence. Use this to 
simulate transfer of kinetic energy, object responses, and difference in material properties in a 
dynamic scene.

Inspector Controls:

Smooth UV: As with Vector Warp, use this to smoothen warp map results across 
neighboring frames.

Smooth Vector: Use this to smooth vectors across neighboring frames. Useful as a 
pre‑processing step before a Vector Warp with texture map.

Attenuate UV: Amplify, decrease, or zero out the warp map effect from the vector 
magnitudes.

Texture UV conversion: Warp maps capture pixel deltas. Use these controls to convert 
between pixel and resolution independent values. Useful when working with assets of 
multiple resolutions.

Vector Denoise
Allows for a general purpose averaging operation across neighboring frames. While similar to 
temporal noise reduction, the source pixels to average are motion vector compensated.

Define the temporal window in number of frames in the Average control, and an upper 
Threshold to ignore flashes and brief highlights when averaging pixel values.

Fusion VR 180 Support
A number of Fusion’s existing VR tools now support 180-degree angle of view. The 180-degree 
VR format allows you to produce immersive content and simplifies the production process for 
VR experiences by focusing on a forward-facing perspective.

Tools:

Spherical Camera: The new option forces the camera to a 180 half spherical angle of 
view. When enabled, this will then force the Renderer3D to output a 1:1 180 LatLong. 
Stereoscopic support is also available in this format, creating Immersive material.

PanoMap: Use the VR180 options in the From and To controls. PanoMap can also be used 
to crop 360 LatLong to VR180 and rotate the source clip to fit the 180 framing.

LatLong Patcher: Use to extract and apply a patch to a VR180 image. This gives control 
to apply traditional 2D effects, like paint, to a 180 distorted clip.

Spherical Stabilizer: Use to stabilize 180 LatLong source material.

Viewer 360 View: Use the new VR180 option in the the Viewer‘s 360 view controls 
to preview 180 degree content and simulate headset movements.
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3D Scene Dome Light
A Dome Light for 3D scenes has been added to Fusion, similar in function to the USD Dome 
Light, but designed to work specifically with Fusion’s 3D environment. A Dome Light uses SDR 
and HDR images and surrounds the entire scene in a sphere light mapped with the image, similar 
to environment light.

The center sphere is a Dome Light tool, being fed by another cityscape image.

Support for Native 
Cryptomatte workflows
The new Cryptomatte tool in Fusion allows you to read embedded mattes rendered into an EXR. 
Instead of relying on manually assigned masks or color keying, Cryptomatte reads encoded 
IDs and isolates them in a way that allows for easy selection. This new tool allows you to create 
mattes for specific objects or materials in a 3D-rendered scene. 

The Cryptomatte tool lets you read embedded mattes from EXR files.

64DaVinci Resolve 20 Fusion



Controls

Layer: Change the layer and matte type to pick (Object, Material, etc.).  
This affects the type of matte you can choose with the Pick control.

Pick: Select mattes from the Viewer or from a list.
	� Click to open a Pick window with a matte list selection. Click and drag or use 

Cmd/Control-clicks to select multiple mattes from the list.
	� Click and drag the control to get an eye dropper cursor to select mattes from the Viewer.

Mode: Add or remove mattes from the Selected Matte list

View Mode: Change the output of the Cryptomatte tool.
	� Colors - Shows the layer IDs as separate colors.
	� Edges - Shows the source EXR with outlined mattes overlayed the image.
	� Beauty - Shows the source EXR.
	� Matte - Outputs a black and white image of the selected matte.

Selected Matte List: The Selected Matte list displays the selected mattes in a List view. 
The selection is highlighted in yellow on the Viewer.

	� Clear - Click the bin icon to remove the selected mattes.
	� Clear All - Click this button to remove all mattes from the Selected Matte list.
	� Clear Selected Layer - Click to remove all mattes from the layer.

View Color Page Grade 
in MediaOut Node
When previewing MediaOut in the Fusion viewer, you can choose to see the clip’s subsequent 
color grade from the Color page.

None: (default) To preview only the composition output.

Color Grade: To preview the clip with composition and color grade adjustments 
from the Color page.

Mix: To preview the overall timeline snapshot of the clip context with color, 
background tracks, overlays, and transitions.

You can now preview your Color page grades in the MediaOut tool
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Faster GPU-based PanoMap 
and Spherical Stabilizer Tools
The PanoMap and Spherical Stabilizer tools have improved GPU acceleration. 

Search Tool Based on Effects Category
When searching for a tool, the results will now be separated by category, rather than just 
alphabetical order, making it easier for you to find exactly the tool you need.

Searching for Material shows all results by Effect 
category, rather than simple alphabetical order.
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User-selectable Starting 
Frames for Compositions
Fusion now allows consistent frame numbering for all compositions, including trimmed clips. 
This means that any composition created in Fusion can start with the same start frame number. 
In new projects in DaVinci Resolve 20, you can change the default start frame for Fusion 
compositions in the Project Settings.

In the Project Settings, you can change the Default Start Frame for Fusion compositions.

This helps with Visual FX workflows in three ways:

•	 Matching existing keyframes to the right frame offsets: When replacing an asset 
with mismatched frame offsets (e.g., a sub clip, different format, or round trip or 
VFX connect workflows with mismatching handles).

•	 Rendering to specific frame ranges: When aligning to delivery standards for 
commercial workflows (e.g., compositions should start at sequence frame 1000).

•	 Consistent Referenced Comp behavior: Essential when applying a referenced 
composition to different clips with different trims.

The legacy frame count behavior continues to anchor Fusion composition zero frames 
to the first frame of the source media for the composition.
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Color
The Color page in DaVinci Resolve 20 has seen major upgrades in the AI behind Magic Mask, 
and presents a new Chroma Color Warper, along with many quality of life improvements.

AI Magic Mask v2 (Studio Version Only)
The underlying AI technology in Magic Mask has been entirely redesigned to provide 
dramatically better results over the previous version, and has been designated Magic Mask v2. 
In addition to better pattern and shape recognition, you will notice the benefits in difficult tracking 
situations, like objects passing in front of the mask and other depth related issues.

Magic Mask v2 user controls remain mostly the same from the original Magic Mask with the 
following new changes:

	� There are no longer separate Person or Object modes. Magic Mask v2 can handle both 
on its own.

	� Drawing Strokes is no longer necessary and has been replaced by simply performing 
Clicks on the object to make a selection.

	� A simple Paint tool has been added to manually paint in or out additional regions from the 
mask on a frame-by-frame basis.

The Magic Mask palette uses the DaVinci AI Neural Engine to automagically create a 
mask to isolate one or more people or objects in the frame, guided by user-applied 
clicks to identify the subject for isolation. Masks can be generated for either an entire 
object, person, or for specific features of that person (their face, hair, arms, shoes, etc.). 
The following images show these two kinds of masks with Highlight enabled in the 
Viewer. A red onionskin overlay lets you see what Magic Mask is isolating.

Using Magic Mask to  
isolate just skin tones

Using Magic Mask to isolate just the apron. 
Note how the color of the apron and shirt are 
very close together, but Magic Mask understands 
the shape of the apron to generate the mask. 

While the masks generated by Magic Mask can often be good enough to use directly 
for making high quality isolated adjustments, it won’t always give perfect results. In these 
cases, the Matte Finesse controls let you make the resulting mask softer and looser, as 
necessary, to clear the edge of a difficult subject you’re isolating with the help of another 
mask generation technique, such as a qualifier key or window. For quick touch up work 
on a frame, you can also use the Paint tool to manually include or exclude regions of 
the mask. 
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If you’re isolating specific features of a person, you can also mix and match what you’re 
isolating to create exactly the type of mask you require. In the above example, you might 
isolate the face, along with exposed skin on the torso and arms, to create a mask for 
creating an overall skin tone adjustment that doesn’t include the subject’s hair or clothes.

This whole process is guided by clicks you make to identify the subject. In a typical 
workflow, you’ll make positive clicks (colored blue) over the person or feature you want 
to isolate. Then, if necessary, you can also make subtractive clicks (colored red) over 
parts of the image that are not the person or feature you’re isolating, to correct any 
problems you see in the generated mask.

Blue clicks identify a person or feature to isolate, while red clicks identify things that shouldn’t be 
included in the mask. In this example, we added a positive click (blue) to isolate the wood cutting board, 
and three subtractive clicks (red) on items that were also roughly wood colored (the wood serving dish 
and pepper grinder on the left, and her arm) to ensure they would never become part of the mask.

Ideally, both positive and subtractive clicks should be centered on the part of the person or 
object you’re trying to add to the mask. If you don’t like the result you’re getting in the mask 
with a particular click you’ve made, you can drag it to another position without clicking again; 
clicks are live and can be selected using the pointer to move or delete them. 

A single blue click on her back 
correctly masks her entire 
body including arms and hair. 
Note Magic Mask v2 correctly 
differentiates her from her 
reflection in the mirror, even 
when they are overlapping.
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As you work, each click shows up in the click list, which lets you select, enable/disable, 
delete, and otherwise manage the different clicks you create to guide automatic 
mask generation.

The Click list keeps track of all clicks you’ve made.

Tracking
After you’ve made one or more clicks to guide the analysis, you can motion track these clicks 
to follow the subject throughout that shot using the tracking controls within this palette. If you’ve 
made multiple clicks, they’re all tracked at once, and each click automatically follows along 
with whatever image details immediately surround that click, so there’s no set up necessary. 
You simply make one or more clicks, then press the track forward or backward button. 
When you track a click, the overall tracking bar shows you which frames have been tracked 
(tracked frames are blue).

Controls let you track all mask analysis clicks forward and backward through the shot.

Once you’ve added the clicks that are necessary to isolate the subject, and you’ve motion 
tracked them to follow along with the motion of the shot, a mask is automatically generated live 
for each frame of the shot. This is important to know because any change you make, adding or 
removing clicks or moving them manually, will alter the resulting mask on the fly.

Fixing Masks with the Paint Tool
Occasionally the Magic Mask might miss its mark over the course of tracking, and include 
something in the mask you don’t want, or exclude something that you do. There is a simple 
Paint tool available in the toolbar to patch up holes in the mask, or remove masked areas from 
the selection. The Paint tool works on a frame-by-frame basis, and so won’t track with the mask. 
It’s great for removing short mask hiccups, but for anything more than fixing a few frames, you 
should go back and refine your mask using the Add and Subtract tools.
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The Plus and Minus Paint tools let you 
add or subtract strokes from the mask, as 
necessary, while the Paint Brush Size tool 
lets you grow or shrink the brush used to 
make the strokes.

The Add/Subtract Paint Stroke 
tools and the Brush Size control

In this frame, Magic Mask accidentally 
included the silver rings on her fingers in 
the mask. For most of the track it did not, 
so we just need to fix a few frames.

Selecting the Subtract Paint Stroke tool 
(green circle), and adjusting its size, we carefully 
paint a hole in the mask over her rings.

The final frame, with the rings 
correctly excluded from the mask

The Magic Mask Interface
The Magic Mask palette is divided into three sets of controls: the Toolbar, the Click list, and the 
Mask Finesse panel. When you first open the Magic Mask palette, it’s empty, and you’re told to 
click in the Viewer to create a mask.

The controls of the Magic Mask palette
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Magic Mask Toolbar
A toolbar at the top contains most of the interactive controls of the Magic Mask palette.

Tracking Controls: The following controls let you track all available clicks to follow camera 
or subject motion in the frame. From left to right, these include: 

	� Go To Reference Frame: Moves the playhead to the frame on which you initially made 
the clicks.

	� Go To First Frame of Tracked Area: Moves the playhead to the first tracked frame of 
a range of tracked frames, in preparation for tracking backwards if there are untracked 
frames at the beginning of the clip.

	� Track One Frame Reverse: Tracks one frame backwards and stops. Useful if you’re 
tracking frame-by-frame to watch the progress of a particularly complicated bit of 
motion. If something goes wrong, you can back up to the last frame where the click 
was able to properly track the subject, and drag the click to a better location using the 
pointer to make it follow the subject properly. If necessary, you can go a frame at a time, 
dragging the click to a better position every time it fails to follow the feature you’re 
using it to isolate.

	� Track Reverse: Continuously tracks from the current frame all the way to the beginning 
of the clip.

	� Stop Tracking: Stops tracking, in cases where there’s a problem with the track and you 
want to make a change.

	� Track Forward and Reverse: Tracks from the current frame all the way to the end of the 
clip, then returns to the original tracking point and tracks backwards to the beginning of 
the clip. 

	� Track Forward: Continuously tracks from the current frame all the way to the end 
of the clip.

	� Track One Frame Forward: Tracks one frame forward and stops. Useful if you’re 
tracking frame-by-frame to watch the progress of a particularly complicated bit of 
motion. If necessary, you can go a frame at a time, dragging the click to a better position 
every time it fails to follow the feature you’re using it to isolate.

	� Go To Last Frame of Tracked Area: Moves the playhead to the last tracked frame of 
a range of tracked frames in preparation for tracking forwards, if there are untracked 
frames at the end of the clip.

Click tools: Two tools at the right let you choose whether to make clicks to identify the 
feature you want to isolate or identify things that aren’t the feature in order to eliminate 
unwanted excursions in the resulting mask. The Plus eyedropper adds an area to the mask; 
the Minus eyedropper removes an area from the mask.

Paint tools: The three paint tools let you do quick touchup work on a mask on a frame by 
frame basis. The Plus paint brush lets you add to the mask, while the Minus paint brush 
lets you subtract from the mask. The Paint Brush Size control lets you change the size of 
the brush.

Invert Mask: A button lets you invert the resulting mask in cases where you want to use 
the feature analysis of this palette to isolate everything except the feature or features 
being analyzed.

Mask Overlay: Turns on an onion-skinned overlay to see what parts of the image are being 
masked alongside which aren’t, so you can continue to refine the result by adding, moving, 
or deleting clicks. The isolated part of the mask is tinted translucent red.
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Click List
Once you start making clicks to identify features for mask generation, they appear in this 
Click list. 

Click list header: The header, at the left of the Click list, has controls for selecting, 
and deleting individual clicks.

Click timeline area: A Timeline Ruler shows the duration of the current clip you’re 
creating a mask for. The Overall Track displays how many frames of each click have been 
tracked. There is a small colored mark (blue or red) on each click track to show where the 
reference frame is.

Mask Adjustment Controls and Matte Finesse
There are two sets of controls for refining the mask that’s output by the Magic Mask palette. The 
first set of controls, at top, let you adjust how the mask is generated based on the analysis data, 
which lets you refine the mask result based on characteristics of the image.

Quality: Two options let you choose a tradeoff between quality and performance. 
Faster lets you generate a lower quality mask more quickly, that’s suitable for 
garbage matting. Better generates a higher quality mask with more detail, that’s more 
processor-intensive.
A second set of mask manipulation controls are for manipulating the mask after it’s been 
generated. Most of these are the same Matte Finesse controls that are available in the 
Qualifier palette, which are useful for trying to fix issues with problem masks, or soften the 
edges when you need to have a more feathered result. 

For more information about the Matte Finesse controls, see Chapter 135, “Secondary 
Qualifiers,” in the DaVinci Resolve Reference Manual. There is one additional control, 
however, that’s unique to the Magic Mask palette.

Consistency: After you’ve tracked each click to follow the subject over the duration of the 
clip, this setting lets you choose how much temporal smoothing is necessary to ameliorate 
jitter in the edges of the resulting mask in areas of low confidence, such as frizzy hair or 
translucent clothing. Higher settings apply more smoothing to the edges of the mask but 
are more processor intensive and may affect how closely the mask follows motion in the 
image. Lower settings will be faster and more accurate but may allow more edge jitter in 
the resulting mask, which can be distracting in the final adjustment you’re making. This 
parameter defaults to 0, so your first application of Magic Mask will always begin with the 
most accurate (and potentially most active) application of this feature’s analysis.

IMPORTANT: Consistency requires a click to have a duration of at least a few frames 
in order to function correctly. This requires you to track each click to follow the motion 
of the camera and subject in order to extend the duration of each click. Because 
Consistency is trying to eliminate one or two frame “noise” in the shape of the mask, 
clicks of short duration may end up having their effect eliminated.

NOTE: The original Magic Mask is still accessible in DaVinci Resolve 20 by selecting 
Legacy Object Mask from the Magic Mask 2 options menu.
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Chroma Color Warper
The Chroma Color Warper is a new tool found in the Color Warper palette. Like the Color Warper, 
its purpose is to make smooth and precise changes between color ranges. The main difference 
is that the Chroma Color Warper uses strokes on a chromaticity diagram rather than adjusting the 
points on a mesh to make its changes. Both will give you great results, but you can only use one 
of these tools per node, either the traditional Color Warper or the Chroma Color Warper.

The Chroma Warper chromaticity diagram on the left, and toolset to the right

The main interface of the Chroma Color Warper contains a chromaticity diagram with the 
range of the current colors in the image overlayed on top in white (similar to a vectorscope 
representation, but not aligned to the traditional vectors), with the toolset to the left. The 
chromaticity diagram is perceptually uniform, meaning that the distances between points on the 
diagram closely align to the visual differences seen in the image when using the Chroma Color 
Warper. The Chroma Color Warper is exposure-independent, meaning once you’ve set a Chroma 
Color Warp, subsequent changes in luminance will not break your qualified selection.

The first decision to make is whether you want to use the Chroma Color Warper in Normal or 
Point to Point modes.

Using The Chroma Color Warper in Normal Mode
Use this mode when you want to naturally transition from one color to another through the 
entire color range that lies between them; for example, changing the color of an entire sky to a 
deeper blue.

Select the color range you want to modify by:
	� Clicking the original color using the Qualifier eyedropper in the Viewer, then dragging 

towards the direction of the new color in the chromaticity diagram. The Viewer will update as 
you drag through the color ranges, allowing you to easily dial in the exact change you want.

	� Clicking on the color representation inside the chromaticity diagram itself, then dragging 
towards the color you wish to change it to.
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In either case, the initial color selected will be represented by a blue dot on the 
chromaticity diagram, and the final color will be represented by an orange dot. They will 
be connected by an arrow showing the range of change. An orange outline around 
the vector shows the entire range of colors modified.

Dragging the points toward the white point (the small circle in the diagram), will 
desaturate the color, while dragging it toward the edges will increase a color’s saturation.

The Chroma Warper in Normal mode, changing both the tonal range  
of the grass to more yellow and the sky range to deeper blue

Using The Chroma Color Warper in Point to Point Mode
Use this mode to isolate and change a specific color to another color entirely; for example, 
changing the color of a shirt from red to blue without going through purple.

Select the specific color you want to modify by:
	� Clicking the original color using the Qualifier eyedropper in the Viewer, then dragging 

towards the direction of the new color in the chromaticity diagram. The Viewer will 
update as you drag through the colors, allowing you to easily dial in the exact destination 
color you want.

	� Clicking on the color representation inside the chromaticity diagram itself, then dragging 
towards the color you wish to change it to.
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In either case, the initial color selected will be represented by a blue dot on the 
chromaticity diagram, and the final color will be represented by an orange dot. They will 
be connected by an arrow showing the range of change. An orange outline around 
both dots shows the selection range of the original and final colors.

Dragging the points toward the white point (the small circle in the diagram), will 
desaturate the color, while dragging it toward the edges will increase a color‘s saturation.

The Chroma Warper in Point to Point mode, changing just the color of the shirt from blue to yellow

TIP: You can use multiple Normal and Point to Point selections concurrently for very 
advanced color changes within the same node.

Pin Points
This tool allows you to set a pin designating a color range to be excluded from the selected range. 
For example, if you wanted to change the color of a sign from red to green, but it had yellow 
lettering that fell into the range between, you could add a pin point to the yellow text to exclude 
it from the color change. Another use case would be to put a pin point on the skin tones of an 
actor so that their skin remained the same regardless of the color changes happening around it.
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You can set a pin point just like the selection above, either by using the qualifier 
on a color in the image itself in the Viewer, or by clicking on the color in the 
chromaticity diagram.

Placing a pin point around the white point to keep  
neutral tones from tinting during a Chroma Warper operation

TIP: If using the tool is causing tinting issues, try placing a pin point on the white point 
of the chromaticity diagram (the center circle). This will remove all neutral grays from the 
color adjustment.

Chroma Warper Tools
The Chroma Warper toolset are where you access the main color selection parameters of the 
Color Warper.

•	 Add Stroke (Normal): This puts the Chroma Warper in Normal mode to select a 
color range.

•	 Add Stroke (Point to Point): This puts the Chroma Warper in Point to Point mode to 
select a specific color.

•	 Add Pin Point: This allows you to set a pin designating a color to be excluded from the 
selected range.

•	 Select: Lets you click on an existing range and drag it around the chromaticity diagram.

•	 Delete Strokes or Points: This lets you delete specific strokes and points you have 
already set on the Chroma Warper. Simply click on one of the points of a range, then 
click on the Trashcan icon.
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Chroma Warper Stroke
The Chroma Warper Stroke tools modify and refine any selection you’ve made.

•	 Chroma Range: Adjust this slider to set the amount of adjacent colors included in 
the range. Lower ranges make the color selection more specific, while higher ranges 
encompass more of the adjacent colors. 

•	 Exposure: Adjusting this slider darkens or brightens the selection in the ending circle 
only (the orange dot). Negative values darken, while positive values brighten.

•	 Tonal Range Low: Adjusting this slider lets you primarily affect the darker regions of 
the initially selected color for change, leaving the brighter regions unchanged. This 
adjustment is global and applies to all strokes in the chromaticity diagram.

•	 Tonal Range High: Adjusting this slider lets you primarily affect the brighter regions 
of the initially selected color for change, leaving the darker regions unchanged. This 
adjustment is global and applies to all strokes in the chromaticity diagram.

•	 Tonal Range Pivot: This slider lets you set the initial point between Tonal Range Low 
and Tonal Range High that those tools diverge from.

•	 Normal/Point to Point Toggle: Clicking on either of these icons changes a Normal 
selection to a Point to Point or vice versa.

Remote Monitor Improvements 
(Studio Version Only)
There have been some significant improvements in DaVinci Remote Monitor, the tool that lets 
you stream the contents of your viewer to other devices over the internet. 

	� You can now view Power Window overlays over the stream.
	� You can now stream in H.265 4:2:2 from macOS.

Samsung Log Colorspace
Samsung Log is now natively supported for color management operations. This allows you to use 
footage recorded in some Samsung Galaxy phones in professional color workflows.

Support for ACES 2.0
DaVinci Resolve 20 now supports ACES 2.0 for color management operations. 
ACES 2.0 includes newly designed output transforms and many other features. For more 
information on ACES 2.0 click here.
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Ability to Generate 
HDR Light Level Reports
You can now generate HDR Light Level reports from the Media Pool. To do so, select a clip in the 
Media Pool, right-click it, and choose Generate HDR Report from the context menu. The tool will 
prompt you to select a location to save the HDR Light Level report in .pdf format.

The report analyzes all frames in rendered HDR clips and presents light level statistics including 
MaxCLL and MaxFALL. It also includes a snapshot of the frame containing the maximum 
luminance level with a box highlighting the point where the maximum values were found.

An HDR Light Level report exported from DaVinci Resolve

LUT and Colorspace Context 
Options in Multi-User Projects
You can now adjust LUTs and Colorspace options from nodes in multi-user projects, just by right-
clicking them and choosing the option you want from the context menu, similar to how it works in 
single user projects.
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Color Panel Improvements
There have been some small quality of life improvements to the Advances and 
Micro Color Panels.

DaVinci Resolve Advanced Panel: You can now go to specific node layers using the 
Advanced Panel.
DaVinci Resolve Micro Panel: The sensitivity for the Lift, Gamma, and Gain rings has 
been improved.

You can update these panels by using the DaVinci Control Panels setup utility.
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Resolve FX
DaVinci Resolve 20 introduces new AI for Depth Map, as well as improvements to the Warper, 
and a new set of OpenColorIO tools.

AI Depth Map v2 (Studio Version Only)
Using new AI, the Depth Map Resolve FX has been considerably improved under the hood in 
DaVinci Resolve 20. While the interface and usage remains the same as the original, you should 
get significantly more precise results from the tool. 

The new Depth Map v2 has replaced the original, and is applied automatically when 
using the Depth Map effect from DaVinci Resolve 20 and above.

The original image

The Depth Map v2 analysis of the scene white for areas 
“closer” to the camera, and black for areas farther away.

Depth Map creates an Alpha channel based on the perceived distance of objects in your 
clip. By being able to isolate a specific depth region, the opportunities to manipulate the 
resulting image are greatly expanded. For more information on using the Depth Map FX, 
see the DaVinci Resolve Reference Manual, Chapter 159.
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Resolve FX Warper
The Warper has been redesigned in DaVinci Resolve 20 to include a new Curves mode, as well 
as a redesign of the tool’s layout.

The Warper is a free-form image warper that uses points or curves to push and stretch features 
in an image as if they were on a sheet of rubber. While the Warper has a lot of options and 
settings, getting started is really easy.

Warp Mode Points
To warp a feature of the image, just select Points as the Warp mode, click anywhere in the image 
to add a warp point, and drag to push that part of the image in the direction you want it to go. 
Warp points are gray. By default, warp points influence the entire image, which is pinned down at 
the corners. This system makes it simple to warp large regions of the image, such as when you 
want to warp an edge of the image to get rid of a boom dip.

(Left) The original image, (Right) The image warped with a single control point

To “pin down” parts of the image you don’t want to warp, Shift-click to place limiter points (which 
are red). By combining warp points with limiter points, you can quickly create extremely specific 
warp effects to squish and stretch features in an image in any way you want.

(Left) The original image, (Right) The image warped with control (gray) and limiter (red) points

As you work, you can Option-click any unwanted warp or limiter point to delete it. To start from 
scratch, you can click the Reset Warp control in the Inspector. Warp and limiter points can be 
keyframed via the Positions and Warp Strength parameters.
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Warp Mode Curves
The Curves mode of the Warper lets you generate the warp around a curve or shape, instead 
of simple points on a grid. This lets you get more specific with your selection and make a more 
organic-looking warp on the image. The Curves mode adds more drawing tools and keyboard 
shortcuts to the Viewer.

To draw a curve, first select Warp Mode Curves, then click in the Viewer where you want the 
curve to start, then drag the line to where you want the next point in the curve, and click again. 
Then continue dragging lines and clicking points until you have the rough line or shape you 
need. Curves can be used open or closed into shapes.

Add, Adjust, and Warp modes
When creating a curve, initially you will be in Add mode; this allows you to create your initial 
curve or shape, however once you’ve closed the shape or pressed Esc to stop drawing, by 
default the Warper will automatically shift you to Adjust mode, which allows you to manipulate 
your curve without adding more points to it. You then switch to Warp mode to move the initial 
curve points to another location, which actually performs the warp. You can have as many curves 
or shapes as you can draw, and if one curve intersects another, a point will automatically be 
placed at the intersection.

You can manually toggle back and forth between Add, Adjust, and Warp modes as needed.

Curve Drawing Commands
While most of the curve editing is done intuitively by clicking and dragging in the Viewer, there 
are also some additional keyboard commands.

Esc: Stops drawing.

Enter: Closes the curve connecting the last point to the first point, or simply click on the first 
point again to close the shape.

Click: Anywhere in the image to start a new curve.

Click: Anywhere on an existing curve to add another point.

Click and Drag: To set a point and drag out its spline handles to adjust its curvature.

Shift-Click: Anywhere in the image to start a Limiter curve. A Limiter curve lets you define a 
shape or area where no warping will take place. A Limiter curve will be in red.

Option-Click: Creates a new line in Add mode, regardless of if you are currently in Adjust or 
Warp modes.

Delete: Removes a selected point or points.
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Drawing curves in the Warper

In the above example, the Limiter (red) shape around the 1 ball prevents it from being 
warped. The straight line on the left is warping the table downward and to the left along 
its edge, as seen by the origin reference (dotted lines), showing where the warp began, 
and the solid line showing where the warp is. The curve over the group of balls to the 
right is showing the spline handles of the currently selected point.

Editing Splines
By default, your “curves” will look more like sharp lines rather than graceful flowing curves. You 
can manipulate the smoothness of the curve by adjusting a point’s spline handles.

A point’s spline handle is seen by clicking directly on the point. If the handles don’t appear, hold 
down the Command key and drag the handles out of the point. By default, spline handles are 
paired; as you move one, the other moves in the opposite direction. You can also manipulate one 
spline handle at a time by holding the Command key and clicking on the single spline handle you 
want to manipulate.

Selection
To select curves and points for modification, you can click directly on them in Viewer. Click on 
the shape again to enclose them in a bounding box. You can select either the whole shape, a 
point, or drag to draw a selection box around certain points. Holding shift and drag to creates a 
freeform selection lasso instead of a box.

Once the box is in place, you can scale the points by dragging the bounding box from its edges. 
You can rotate the selection by hovering the mouse near the edge of the box until the Rotate tool 
appears, then click and drag to rotate. Holding Option and dragging scales the shape around the 
geometric center of the box.
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Drawing a bounding box around a curve lets you scale and rotate it

Warper Settings

Warp Mode: Choose which control mode to apply the warp, either using Curves or Points.

Curves

Add: With this mode selected, you can add points to create a curve or shape to 
warp around.
Adjust: With this mode selected, you can adjust the curve or shape that you’ve created, 
isolated from the warp.
Warp: With this mode selected, the image will warp around the curves or shapes that 
you’ve created, and update in real time as you move them.
Render a Reference Grid: Check this box to add a reference grid over the image, so you 
can see just how much the warp is affecting each area of the frame.
Origin Reference: Adjusting this slider will adjust the visible intensity of the original curve 
and point locations. Slide to the right to increase the intensity, slide to the left to make them 
transparent.
Position Keyframing: Keyframes the positions of the curve points.
Warp Keyframing: Keyframes the warps of the curve points.
Warp Strength: Adjust this slider to magnify or reduce the distortion effect of the warp.

Selected Points

Symmetric: Makes the selected point, or all points on selected curve, symmetric to the 
selected control point.
Corner: Makes the selected point, or all points on selected curve, hard corners.
Rounded: Makes the selected point, or all points on selected curve, rounded corners with 
spline controls.
Reset Handle Adjustments (Warp mode): Click this button to reset the spline curve 
adjustments of a point back to neutral.
Reset Warp (Warp mode): Click this button to reset the warp back to its original 
neutral state.
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Selected Curve:

Show All Handles: This checkbox toggles on or off all the spline handles for all the points 
on a curve.
Open/Close: Click this button to toggle closing a curve (connecting the last point to the first 
point), or opening a curve (removing the connection).
Warper / Limiter: Click this button to toggle a curve between a Warper or Limiter curve. 
A Limiter curve prevents warping in its defined area.
Delete: Deletes an entire curve.

Points

Render a Reference Grid: Check this box to add a reference grid over the image, so you 
can see just how much the warp is affecting each area of the frame.
Positions: Keyframes the positions of the points in the Viewer.
Show Origin Locations: Shows the original location of each point in the Warper.
Clear All Points: Deletes all added points, and returns the Warper to its neutral state.
Reset Warp: Resets the Warper to its neutral state, but retains all added points at their 
origin position.
Warp Strength: Adjust this slider to magnify or reduce the distortion effect of the warp.

On-Screen Controls

Show: Shows the on-screen controls in the Viewer.
Auto Hide: Shows the on-screen controls in the Viewer, but hides them only as they are 
adjusted, letting you see the final image while making adjustments.
Hide: Hides the on-screen controls in the Viewer.
Warp Boundaries (Points Only): This popup menu has three choices for letting you see 
which areas of the image will be locked off by limiter points you place in the image. 

	� None: Hides this information and is the default setting. 
	� As Border: Shows a red line at the boundary where warping becomes locked off. 
	� As Mask: Dims the area that’s protected from warping by limiter points.

Scale Controls: This slider lets you shrink or grow the control points or warp vector handles 
to the most convenient size for the task at hand.

Advanced Options

Limits: A popup menu lets you choose how to treat the edges of the image when you’re 
warping it.

	� Pin at Corners: Lock the four corners of the image in place, but allow the sides to bulge 
in or out as you warp and allowing blanking to creep in. 

	� Around the Edges: Locks the full width and height of all four edges in place as you 
warp, preventing blanking. 

	� Distant: Locks parts of the image that are n pixels away, but the default setting is very 
permissive. 

	� Manual (Free-Floating): Allows the entire image to be warped without locking any part 
of it, allowing for extreme warps all along an entire edge of the image, but requiring you 
to place at least one Limiter point prior to adding a Warp point.
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Elasticity: A popup menu lets you choose one of three methods of interpolating how the 
image bends around a Warp point: Fabric, Rubber (the default), and Jelly. Fabric produces 
the “most pointy” warps, while Jelly produces the most gently curved warps. Rubber strikes 
a balance between the two extremes.

Fabric Rubber

Jelly

Edge Behavior: A popup menu eliminates any blanking caused by warping that affects 
the edge of the image by filling black areas in one of several user-defined ways; options 
include Black (do nothing and leave the blanking), Reflect, Wrap-Around, and Replicate.
Warp Detail: A popup menu lets you choose from among three methods of calculating the 
warping effect you’re creating: Faster, Default, and Better. Each choice is an obvious trade-
off between image smoothness and performance.
Effect Follows: Allows you to choose whether the points stick to the scaled content (Input 
and Edit Sizing), or the original frame in the timeline (Timeline Frame).
Auto Advance to Adjust Mode: When this box is checked, after adding a point or curve, 
automatically switch to Adjust mode to edit it.

Resolve FX OpenColorIO
A new category of OpenColorIO Resolve FX has been added to DaVinci Resolve 20. 
OpenColorIO (OCIO) is an open color management system created by the Academy Software 
Foundation. It is used by many professional vfx and editing programs (including DaVinci Resolve 
and Fusion) to ensure color accuracy throughout the production pipeline.

OCIO CDL Transform
The OCIO CDL Transform FX lets you create, save, and apply standard Color Decision List 
(CDL) grades to or from the node. A CDL exchanges basic primary color information from one 
application to another.
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CDL File: Clicking Load will allow you to load a Color Decision List (.cc or .ccc) file to the 
controls. CC is a single CDL and CCC is an archive of multiple CDL looks. If loading a 
CCC file, another CCID field appears and lets you chose the name or number of the index. 
Type the name or number and press Reload to load the new version.

Reload: Lets you reload a CDL after choosing another name or number from the index of 
a CCC file.

Export: Exports the current settings in Controls as a new .cc file.

CDL Controls:
These controls let you modify the basic color information of the node, which can be 
exported as a CDL file for other applications to read. These controls: Slope, Offset, 
Power, and Saturation are how the American Society of Cinematographers encode color 
information. The color controls are self explanatory, but without getting deep into the math, 
these controls allow you to adjust color in either a film- or video-based manner as below:

	� Slope is essentially Gain
	� Offset is essentially Exposure
	� Power is Essentially Gamma
	� Contrast is a combination of Slope and Offset
	� Lift is a combination of Slope and Offset

Forward: Applies the CDL changes to the Node.

Reverse: Attempts to remove the CDL changes from the node. For example, if you receive 
some footage with a baked in color grade, reversing the CDL used will remove those 
changes back to the original ungraded source material. However, not all color correction 
can be undone.

Export: Exports the current settings in Controls as a new .cc file.

OCIO Color Space
This effect allows you to to do color space transforms using an OCIO config file (.ocio).

OCIO Config File: Click Browse to load a .ocio config file for the color space transform.

Source Space: Based on the config file, the available source color spaces are listed here. 
The content of this list is based solely on the loaded profile and hence can vary immensely.

Output Space: Based on the config file, the available output color spaces are listed here. 
The content of this list is based solely on the loaded profile and hence can vary immensely.

Look: Installed OCIO Color Transform Looks appear in this menu. If no looks are installed, 
this menu has only None listed as an option.

Forward: Applies the Color Space changes to the Node.

Reverse: Attempts to remove the Color Space changes from the node.
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OCIO Display
This effect allows you to to view display transforms using an OCIO config file (.ocio).

OCIO Config File: Click Browse to load a .ocio config file for the display transform.

Source Space: Choose the color space of the source material from the list.

Display: Choose which monitor and type your viewer is on.

View: Choose which color space to view on your monitor.

OCIO File Transform
This effect allows you to to load and apply Look Up Tables (LUTs) to the node.

LUT File: Click Browse to load a LUT from the file browser.

CCC ID: This is the ID key used to identify the specific file transform located within 
the ASC CDL color correction XML file.

Forward: Applies the LUT to the node.

Reverse: Attempts to remove the LUT from the node. 

Interpolation: Allows the user to select the color interpolation to achieve the 
best quality/render time ratio.
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Fairlight
DaVinci Resolve 20 includes the following new Fairlight features and improvements. 

AI IntelliCut
AI Intellicut offers the following group of AI-driven functions.

AI Remove Silence
To increase efficiency in your workflow, this feature offers a quick, non-destructive way to remove 
silent sections from your timeline clips.

Audio clip with silence indicators

To remove silences from a timeline clip:

1	 Using the Range tool, select a clip or collection of clips on a track.

2	 Right-click the selection and choose Remove Silence in the contextual menu.

3	 The appearance of the selected audio will change to include vertical red stripes showing 
you the position and duration of the resulting silences based on the current parameter 
in the Remove Silence dialog. 

Remove Silence dialog
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Remove Silence Parameters 

Threshold: This determines the maximum signal level of your audio (in dB) that will be 
recognized as silence. Audio signals below the threshold value will be treated as silence 
and removed. Higher threshold values result in more audio being removed.

Pre Head: Sets the amount of silence or pre-roll before each audible section.

Post Tail: Sets the duration of silence or post-roll after each audible section.

Minimum to Strip: This parameter determines the minimum amount of silence 
(in milliseconds) to be stripped from selected timeline clips.
Higher values leave more silent sections in the audio. Lower values will result in 
more strips, but you may find that some of the remaining audio sounds “chopped up” 
because it abruptly cuts off.

Fade Head and Tail: When this checkbox is filled, fades are applied to the beginning and 
end of each remaining clip based on the Pre Head and Post Tail values.

AI Checkerboard to New Tracks
This feature is useful in situations where, for example, multiple actors are recorded with a boom 
mic on a single track, and you would ideally like each voice on a separate track to make mixing 
your project a lot easier.

To split speakers to new tracks:
1	 Right-click the timeline clip and choose AI Tools > Checkerboard to New Tracks in the 

contextual menu. 

Ai Tools contextual menu

2	 When the Transcribing Audio dialog opens, Fairlight will use AI to analyze the audio and 
identify each voice. 

Transcribing Audio dialog
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3	 A new track is created for each speaker, containing their new clips. The source track will be 
muted, leaving the original timeline clip intact. 

New track timeline clips for each speaker

AI Create ADR Cues
To enhance your ADR workflow, this AI feature analyzes and transcribes a selection of timeline 
clips on a track and generates individual ADR cues.

NOTE: The dialogue must be spoken in one of the supported languages listed in the 
Project Settings under Subtitles and Transcriptions > Language. For more information 
about audio layering, see Subtitles and Transcription in Chapter 6, “Project Settings,” 
in the DaVinci Resolve Reference Manual.

Create ADR Cues offers the following output options which are explained below: 

Timeline clip contextual menu for creating ADR cues

Create ADR Cues
Right-clicking a selection of timeline clips on a track and choosing AI Tools > Create ADR Cues 
from the contextual menu opens the Transcribing Audio dialog, showing the progress of the 
analysis and transcription. Once the dialog closes, the transcribed cues are added to the List 
page in the ADR panel, along with their Cue ID, Time In/Out, and Durations. 

New ADR cues
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Create ADR Cues with Speakers
Right-clicking the timeline clip selection and selecting AI Tools > Create ADR Cues with Speakers 
in the contextual menu adds the transcribed cues to the List page as described above, along 
with the Speaker name in the Character column. 

New ADR cues with speaker names added to the Character column

AI Dialogue Matcher
AI Dialogue Matcher is helpful when you need to match the ambient quality of one timeline 
clip to another. For example, in a dialogue replacement scenario, you may need to make the 
newly recorded dialogue sound like it was recorded in the same room as the rest of the on-
location dialog.

In this situation, AI Dialogue Matcher helps you apply the room characteristics of the original on-
location audio to the newly recorded dialogue. 

Timeline clip Dialog Matcher contextual menu

To apply AI Dialogue Matcher:

1	 Right-click the timeline clip you want to match and choose AI Tools > 
Dialogue Matcher > Capture Dialogue Profile from the contextual menu.

2	 When the audio has been analyzed, right-click the timeline regions you want to 
apply the profile to and choose AI Tools > Dialogue Matcher > Apply Dialogue 
Profile from the contextual menu.

Once the dialogue profile is applied, you will see a checkmark next to the Enabled 
option in the Dialogue Matcher contextual menu. Clicking this checkmark toggles the 
dialogue profile on and off. Selecting Remove Profile removes the profile from the 
clip entirely.
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AI EQ Matcher
AI EQ Matcher can be used in situations where, for example, you need to quickly apply the tonal 
characteristic (EQ Profile) of on-location dialogue recorded with one type of microphone to newly 
recorded dialogue recorded in post using a completely different microphone.

To capture and apply an EQ Profile:

1	 Right-click the timeline clip you want to match and choose Clip Operations > 
EQ Matching > Capture EQ Profile from the contextual menu. 

Timeline clip EQ Matcher contextual menu

2	 Apply the captured EQ Profile to new audio clip in one of the following ways:

•	 Apply to Clip EQ: This applies the same EQ setting to the Equalizer plugin for each 
selected clip on the destination track.

•	 Apply to Track EQ: Applies the EQ profile to the whole track and the applied 
EQ curve will appear in the EQ section of the corresponding Mixer channel strip. 

New EQ curve displayed  
in a Mixer channel strip

•	 Apply to Automated Track EQ: This option is useful when you have multiple clips 
on a track, each requiring its own unique EQ setting to maintain a correct tonal 
match during playback. This selection lets you quickly write automation data, which 
adjusts the Track EQ curve for each clip, as required.
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To apply the EQ profile to an automated track EQ:

•	 Right-click the timeline clip you want to match and choose Clip Operations > 
EQ Matching > Capture EQ Profile from the contextual menu.

•	 Ensure the Toggle Automation button to the right of the transport control is active (red), 
then select an EQ parameter from the Automation dropdown in the destination Track 
Header, for example, EQ > Band 3 > Gain.

•	 Right-click the first clip you want to apply the EQ profile to and choose Clip Operations 
> EQ Matching > Apply to Automated Track EQ. Repeat this step for subsequent clips 
on the track.

As you repeat the previous step, you will notice the automation curve changing 
with each application of the EQ Profile.

During playback, the EQ Curve display in the corresponding mixer channel strip 
will change based on the automation data and Playhead position.

AI Level Matcher
AI Level Matcher lets you match the clip volume of disparate timeline clips quickly and accurately 
to each other.

To match your clip levels with the Level Matcher:

1	 Right-click on the timeline clip you want to match and choose Clip Operations > 
Level Matching > Capture Level Profile. 

Timeline clip Level Matcher contextual menu

2	 Right-click on a timeline clip you want to adjust and choose Clip Operations 
> Level Matching > Apply Level Profile. Repeat this step for any other timeline 
clips you want to change.

AI Music Editor
The DaVinci Resolve AI Music Editor lets you lengthen or shorten music cues by creating 
seamless, intelligent edits like a human music editor would do. This is achieved without using 
time compression or changing the pitch.

This technology works best with beat-driven music (rock, pop, hip-hop, etc.), rather than ambient 
or more free-form music.
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Using AI Music Editor

1	 Select the timeline clip of your music and go to the AI Music Editor in 
the Audio Inspector 

Ai Music Editor dialog

2	 Once you have determined how long the cue needs to be, enter the length 
of time in the Target Length box and click Adjust.

An AI Music Editor dialog will open, displaying a progress bar with the option to 
cancel the process, if needed. 

Ai Music Editor progress

The process will try to get as close as possible to the desired length, while 
delivering four musically seamless edits you can switch between using the buttons 
in the Versions section.

•	 Live Trim: Activating this function lets you dynamically trim the clip length on the 
timeline. When you have created an edit you like, you can remove the checkmark 
if you want to go back to editing (trimming) the clip normally.

TIP: If an edit ends abruptly, it can be fixed by manually creating an 
appropriate fade‑out.

If the duration of an edit isn’t exactly the length you need, you can use the 
Elastic Wave tool and select the general purpose (music) algorithm.
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AI Audio Assistant
With the new AI Audio Assistant, DaVinci Resolve can automatically organize and color code 
your tracks, even out your dialogue levels, and adjust the Fairlight mixer faders to create a 
professional-quality mix of your music, sound effects, and dialogue.

During this process, your dialogue will also be cleaned up, and if needed, Voice Isolation and 
De-Essing will be applied. Ducking will be applied to music tracks, any required automation will 
be written, and the appropriate mastering and finalizing plugins will be added and adjusted to 
help achieve the correct loudness level for your chosen delivery standard.

To use AI Audio Assistant:

1	 Open a timeline containing unmixed audio. The initial fader levels really don‘t matter 
as Audio Assistant will handle all fader adjustments during the mixing process.

2	 Ensure that you do not have differing audio elements on the same track.

3	 To begin the automatic mixing process, choose AI Tools > Audio Assistant from the 
Timeline menu, select the Delivery Standard for your mix from the dropdown menu, 
and click the Auto Mix button. 

Audio Assistant dialog 

4	 The Audio Assistant dialog changes to display the progress of the mixing process 
with an option to cancel it. 

Audio Assistant dialog - Mix progress

5	 When the mixing process has concluded, you can play back the mix and, 
if needed, make further adjustments or completely undo it.
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NOTE: If a track is in the wrong category, right-click the corresponding track 
header and choose the correct category from the Track Category section of the 
contextual menu.

Clip EQ Improvements
The Clip EQ in the Audio Inspector now support six bands, with the ability to copy and paste 
setting between other Clip EQ instances.

Miscellaneous Improvements
Improved clip gain display for multichannel clips on the timeline.

Improved responsiveness when drawing clip waveforms for timelines with lots of clips.

New Hairline display mode for timeline markers.

Tracks and busses can be rearranged in the Timeline by dragging the Header color 
up or down.

Automation Improvements:

	� Automation now supports per channel mode switching. 
	� Trim automation now remains active through a mix pass.
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Deliver
DaVinci Resolve 20 has added several codec and export options to the Deliver page.

Quick Export Dialog Improvements
The Quick Export dialog in DaVinci Resolve 20 has been improved, allowing you to add your 
own custom user preset listings and see all export options in a List view.

The Quick Export dialog showing a custom preset

To Create a New Custom Preset and Add it to Quick Export:
1	 On the Deliver page, select Custom Export from the Render Settings, and adjust the 

Video, Audio, and File settings for your new preset. Only Single Clip settings can be made 
Custom Presets, not Individual Clips.

2	 In the Render Settings 3-dot option menu, select Save as New Preset.

3	 Type in a name for your new Preset, and choose a preset icon to represent it.

4	 Check the Add to quick export box.

5	 Click Save.

Your preset and icon will now be added to the Quick Export dialog across all pages of 
DaVinci Resolve and also be added to the Render Settings in the Deliver page.
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The List View icon (circled) in the Quick Export dialog

To View the Quick Export Options in List View:
1	 Open the Quick Export dialog.

2	 Click on the List View icon in the Render Settings.

Assign Icons to User Presets
When you create a new Custom Preset in the Deliver page, in addition to entering a 
name, you can now choose an icon from the list to represent it in the Render Settings and 
Quick Export dialog. 

Creating a new Custom Preset in the Deliver page
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Interlaced Rendering for 
Frame Based Formats
By default, frame-based media sources (image sequences, etc.) are rendered progressively. 
You can now optionally render them as interlaced media instead in the Deliver page.

The Interlaced rendering checkbox appears 
when using frame-based source material.

To Render Interlaced Deliverables from Frame-Based Sources:

1	 In the Video tab of the Render Settings, check the box: Interlaced rendering.

2	 Select the Field Order to encode, either top or bottom field first.

Codec Support
As always, each new version of DaVinci Resolve adds new codecs to support the latest cameras 
and technologies.

ProRes encoding support is now available on Windows and Linux systems.

Encode MV-HEVC without spatial video metadata.

MV-HEVC encode support on Nvidia systems.

Support for side-by-side stereo 3D media decode.

Side-by-side display mode for stereo 3D clips in Source Viewer.

Editable spatial video metadata properties in Inspector.

GPU-accelerated H.265 4:2:2 encodes on supported Nvidia systems. 

GPU-accelerated H.265 4:2:2 decodes on supported Nvidia systems.

101DaVinci Resolve 20 Deliver



Support for growing TS, MTS, and M2TS files as media streams.

Support interlaced rendering for frame-based formats.

HT JPEG 2000 decode support for EXR.

Quick Export dialog with custom user preset listings and List view.

Ability to assign custom icons to user presets in the Deliver page.

Support for Sony Burano 2.0.

Support for RED SDK 8.6.

Support for audio normalization for Dropbox presets.
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